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Disclaimer

12d Model is supplied without any express or implied warranties whatsoever.
No warranty of fitness for a particular purpose is offered.

No liabilities in respect of engineering details and quantities produced by 12d Model are accepted.

Every effort has been taken to ensure that the advice given in this manual and the program2d Model is
correct, however, no warranty is expressed or implied by 12d Solutions Pty Ltd.

Copyright
This manual is copyrighted and all rights reserved.

This manual may not, in whole or part, be copied or reproduced without the prior consent in writing from
12d Solutions Pty Ltd.

Copies of 12d Model software must not be released to any party, or used for bureau applications without
the written permission of 12d Solutions Pty Ltd.

Copyright (¢) 1989-2025 by 12d Solutions Pty Ltd

Sydney, New South Wales, Australia.
ACN 101 351 991
All rights reserved.
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1 A Guide to the Notes

These notes contain the information for:

(a) Installing the release version of 12d Model

12d Model needs to be installed on each computer it is going to run on.

For notes on installing 712d Model for the first time, or on a computer that is already running
12d Model, go to 2 Installing 12d Model 15 Release Version on page 6

(b) Setting up if you are using Network licences

By default when 72d Model is installed it is set up for users with a Local (single user or
stand alone) CodeMeter that only allows 72d Model to be run on the computer with the
Local CodeMeter attached to it. With a Local CodeMeter, if 12d Model is to be run on
another computer with that Local CodeMeter then the Local CodeMeter must be moved
to the new computer. And 712d Model will stop running on the computer that no longer has

the Local CodeMeter attached to it.

To allow 72d Model to run on a number of computers without having to move a CodeMeter
to different computers, 12d Model has network licences and for those cases, a NETWORK

CodeMeter is used.

/ / 12d Local CodeMeter also referred to as a
Single User or Standalone CodeMeter

KKNote: the end cap and ring are cosmetic only

Stubby USB Long USB
with end cap without end
and ring cap and ring i

\

KZd Network CodeMeter\\

Silver USB

_. i o
&

Y
L c/

/

o

%

For notes on setting up a Network CodeMeter, go to 10 Network CodeMeters on page 51
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2 Installing 12d Model 15 Release Version

2.1 Requirements for Installing & Running12d Model 15

Before Installing and running 72d Model 15, you need the following:

(a) You must have Administrator privileges to install 72d Model
(a) Approximately 2 Gigabytes of disc space is required for the installation to succeed.
(b) A 12d Model CodeMeter or Wibu Lock for your computer

If 12d Model 15 is already running on your computer, the CodeMeter (or Wibu) lock you
already have will work with the new version of 12d Model 15 once you have a nodes file for
12d Model 15.

If 72d Model has NOT been running on your computer then DO NOT ATTACH THE LOCK
TO YOUR COMPUTER until after the CodeMeter/Wibu drivers have been installed as part
of the installation procedure.

(c) An email with the 72d Model 15 authorization file nodes.12d15n attached, or a folder with
the 712d Model 15 authorization file nodes.12d15n or nodes.4d in it.

(d) This document which has the internet links to the required executables and files
(e) Access to the internet to download the required executables and files

Please check that you have all the above items before commencing the installation.

Also note that:
(a) 12d Model 15 will not install on Windows XP or Windows Vista.

(b) 12d Model 15 will not run with the brand Hardlock locks which were used for 12d Model 10
and earlier versions. They were either parallel locks or purple USB locks.

If you have a 12d Hardlock lock, please contact your 12d Model Reseller to obtain a
replacement CodeMeter lock.

(c) 12d Field will only run with CodeMeter locks

If you are running 72d Field and have a 12d Wibu or 12d Hardlock lock, please contact
your 12d Model Reseller to obtain a replacement CodeMeter.

(d) A three-button mouse is essential to efficiently use 72d Model on the desktop.

2.2 12d Model 15 1s only 64 bit

Microsoft has a 64 bit Windows and an older 32 bit Windows operating system but 712d Model 15
is only being released for 64-bit Windows.

2.3 Quick or Detailed Installation Notes

For abbreviated instructions and links for Installing the Release Version of 72d Model, go to 3
Quick Installation Notes for 12d Model 15 on page 7.

For detailed instructions and links for Installing the Release Version of 12d Model, go to 4_
Detailed Notes for Installing 12d Model on page 12.
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3 Quick Installation Notes for 12d Model 15

This chapter contains abbreviated notes for Installing 72d Model 15, and the links to download
all the files required for the installation.

For more detailed notes on installing 72d Model, see 4 Detailed Notes for Installing 12d Model
on page 12.

Important Note: 12d Model 15 will not install on Windows XP or Vista.

3.1 Installing and Uninstalling

(a) You need to be Administrator to install 72d Model 15 and CodeMeter and/or Wibu drivers
(b) 12d Model 15 is 64-bit only - there is no 32-bit version.

(c) You can have earlier versions of 712d Model, both 64-bit and a 32-bit, on your computer at
the same time as 72d Model 15.

(d) If 172d Model 15 is already installed on your computer then it will be replaced.

The 12d Model 15 Installer checks for an existing matching 72d Model 15 and if one
exists, it displays the version number and asks if you want to Uninstall it.

If you say No then the 12d Model 15 Install will terminate, leaving the existing
12d Model 15.

Important Note

The Uninstaller deletes everything in the Program Files\12d\12dmodel\15.00 folder so do
not modify any of those files as they will be deleted by any future installs of 12d Model 15.

Any modification that you make to these files must go into User or User_Lib.

(e) The Uninstaller will not delete any of the training material loaded into the folders
12d\15.0\training and 12d\15.0\courses.

The 12d Model 15 Installer will overwrite any files of the same name in those folders.
(f) Do not attach the CodeMeter or Wibu locks before installing the drivers

The 12d CodeMeter or 12d Wibu locks (dongles) must NOT be attached to the computer
before the CodeMeter/Wibu drivers are installed (see 3.5 CodeMeter Drivers on page 8).

3.2 Hardware Locks (Dongles) Supported

(a) The brand Hardlock locks CAN NOT be used for 12d Model 15.
(b) 12d Field is only available in 72d Model 15 for CodeMeters.
(c) Network CodeMeters only support 712d Model 11 and above.
(

d) The older Wibu locks (non-CodeMeter) are supported for 12d Model 15 but are being
phased out.
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3.3 12d Model 15 and CodeMeter Drivers

The installer for 72d Model installs both 712d Model15 and the appropriate CodeMeter Drivers
which are needed to access the 72d Model licences.

The 12d Model Install for 64 bit Window 10 - approximately 1 Gb
https://downloads.12dmodel.com/v15/12d_Model_15_C1t/12d_Model_15_C1t 64_Setup.exe

For notes on installing the exe, see 4 Detailed Notes for Installing 12d Model on page 12.

3.4 Certifying CodeMeters

A CodeMeter needs to be Certified over the Internet every two months. So you need to have
access to the Internet for the first time you start up 72d Model with a CodeMeter and then at lest
every two months.

Once 12d Model is installed, there is an environment variable AUTO_CERTIFY_DONGLE_4D
that can set so that 712d Model automatically certifies the CodeMeter when required.

For notes in certify CodeMeters, see 5 Certifying CodeMeters on page 30.

Please contact your 12d Model Reseller if you have any problems Certifying CodeMeters.

3.5 CodeMeter Drivers

If you need to install the CodeMeter drivers separately to using the 72d Model install, they can
be installed with:

https://downloads.12dmodel.com/v15/12d_Model _15_C1t/CodeMeterRuntime_8 20.exe

For notes on installing the CodeMeter Drivers, see 5.4 Installing the CodeMeter Drivers
Separately on page 35.
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3.6 For Users with 12d Model 14 Installed
3.6.1 Setting Up Your User Folder for 12d Model 15

The folder User contains the files that you have modified to replace those that 72d Model installs
in the folder Set_ups. For example, your own names.4d or linestyl.4d.

So if you have files in your User folder in 12d Model 14, you will probably also want to use many
of them with 12d Model 15.

In 12d Model 14, the default place for User is ¢:\12d\14.00\User but it could also be pointed to
by the environment variable USER_4D.

For 12d Model 15, you need to create a new User folder.

You need to check each file in the 72d Model 14 User folder and see if it needs to be modified
for 12d Model 15.

Once each file is OK, copy to it to the 72d Model 15 User folder

The default location for the 712d Model 14 User folder is ¢:\12d\14.00\User but if the
environment variable USER_4D was used to point to a different location for the User folder in
12d Model 14 then you will probably want to use a non-standard User folder for 72d Model 15. If
that is the case then you will need to change USER_4D in the env.4d file for 12d Model 15 to
point to your User folder for 12d Model 15.

3.6.2 Setting Up Your User Lib Folder for 12d Model 15

The folder User_Lib contains your own library files and if you had files in a User_Lib folder in
12d Model 14, you will probably also want to use many of them with 72d Model 15.

In 12d Model 14, the default place for User_Lib is ¢:\12d\14.00\User_Lib but it could also be
pointed to by the environment variable USER_LIB_4D.

For 12d Model 15, you need to create a new User_Lib folder.

You need to check each file in the 12d Model 14 User_Lib folder and see if it needs to be
modified for 12d Model 15.

Once each file is OK, copy to it to the 712d Model 15 User_Lib folder

The default location for the 712d Model 14 User_Lib folder is ¢:\12d\14.00\User_Lib but if the
environment variable USER_LIB_4D was used to point to a different location for the User_Lib
folder in 72d Model 14 then you will probably want to use a non-standard User_Lib folder for
12d Model 15. If that is the case then you will need to change USER_LIB_4D in the env.4d file
for 12d Model 15 to point to your User_Lib folder for 12d Model 15.

3.6.3 Setting Up Your env.4d File for 12d Model 15

The file env.4d contains environment variables that are used to customise 72d Model.

An env.4d file is installed it the Set_Ups folder when 12d Model is installed and if a user wants
to make any modifications to any of the environment variables in env.4d, then the modified
env.4d file is placed in the User folder.

So if you have an env.4d file in your User folder in 12d Model 14, you will probably also want to
use it 72d Model 15.

First check the env.4d file to see if any changes need to be made to it for 12d Model 15.

The default location for your modified env.4d file in 12d Model 14 is in your User folder for
12d Model 14 so for 12d Model 15, you need to copy the modified env.4d file to your User
folder in 12d Model 15.
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3.6.4 Are You Using a 12d Network Lock?

If you are using a 12d Network Lock (CodeMeter or Wibu) for 12d Model 15, then the file
dongles.4d which is in the User folder contains the information to tell 12d Model that it has to
search for a network lock, and possibly which computer the network lock is on.

So if you are using a 12d Network Lock for 12d Model 14, you will need to copy your
12d Model 14 dongles.4d file to the 12d Model 15 User folder.

3.7 Network CodeMeters

3.7.

3.7.

1 Using a 12d Network CodeMeter for the First Time

If you are setting up 72d Model to use a 12d Network CodeMeter for the first time, please read
the section 10 Network CodeMeters on page 51.

2 Updating Licenses in a Network CodeMeter

If you are modifying the virtual 712d Model dongle within a Network CodeMeter (for example
increasing the number of licenses), go to section 11.5 Updating Licenses in Network CodeMeters

on page 111.
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3.8 Documentation and What’s New

The links for downloading documentation on 72d Model are given in 6 Documentation on
page 40.

The links for downloading documentation, power points and videos on what is new in
12d Model 15 are given in 7 What's New in 12d Model 15 on page 45.

This ends the Quick Installation notes for 72d Model 15.

The rest of the Chapters in this document are:

4 Detailed Notes for Installing 12d Model on page 12

5 Certifying CodeMeters on page 30

6 Documentation on page 40
7 What's New in 12d Model 15 on page 45
8 12d Model Training on page 46

9 Errors Installing and Authorising on page 47

10 Network CodeMeters on page 51
11 CodeMeter Control Center & WebAdmin on page 79
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4 Detailed Notes for Installing 12d Model

These are the complete notes are for installing the Release version of 72d Model 15 using
CodeMeter locks. If you are using the older Wibu locks, please contact your Reseller for the
installation notes.

Disk Space required for installing 72d Model 15
Approximately 3 Gigabytes of disc space will be required for the installation to succeed.
Before installing 72d Model, it is best to reboot the computer.

Your login must have Administrator privileges.

Do not attach the 12d Model locks before installing dongle drivers

If you are installing 72d Model on your computer for the first time, the 12d CodeMeter lock must
NOT be attached to the computer before the CodeMeter drivers are installed during the
12d Model installation.

Installing

The following Steps will take you through the combined installation 72d Model and the
CodeMeter drivers, and the setting up of the nodes.4d file.

Continue to Step 1. Installing 12d Model 15 Release Version and CodeMeter Drivers on page 13.
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Step 1.  Installing 12d Model 15 Release Version and CodeMeter Drivers

The installer for 12d Model 15 is downloaded from the internet.

(a) Installing 72d Model and CodeMeter Drivers from the Downloaded Files:
To download the installer for 12d Model, click on
https://downloads.12dmodel.com/v15/12d_Model 15 _C1t/12d _Model 15 _C1t 64 Setup.exe

Note: If clicking on the link does not start up your Browser then copy the text of the link into
your Browser.

Once the installer is downloaded, click on it (or run it) and the 712d Model installation begins.

You may get a message warning you about not being able to verify who created the file:

Open File - Security Warning &J

We can't verify who created this file. Are you sure you want to
run this file?

@ Name: L\12d_cd1 2\DVD\Setup'64\Release\Setup.exe
Type: Application
From: EV12d_cdi12\DVD'\Setup'64'\Release\Setup.exe

Run I [ Cancel

I ¥ | This file is in a location outside your local network. Fles from
@/ locations you don't recognize can ham your PC. Only run this file #
= you trust the location. What s the risk?

w

Click on Run so that the installation can begin.

The 12d Model 15 installation starts by unpacking the information in the installation exe and then
the installation begins.

‘ii. 61% Preparing installer... @
Please wait while the instzller is prepared...

Cancel

If the Installer detects there is an existing version 12d Model 15 already installed, you will be
asked if the Installer can uninstall the existing version. Unless this is done, the installation can

not proceed.

Note: The uninstall deletes everything in the Program Files\12d\12dmodel\15.00 folder so you
should never modify any of those files.
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12d Model 15 - 84 bit

24-03-2022 ) is already installed!

e Another version of this product | 15.0C1 ¢ [DEVELOF] IMT Build
Waould you like to uninstall it now?

Click on Yes to continue.

You then receive a Warning that the files will be deleted.

Warning! Proceeding with the uninstaller will delete all files
! from your installation directory.
Are you sure you wish to continue?

Yas Mo

Click on Yes to continue.

All the files in the Program Files \12d\12dmodel\15.00 folder will then be deleted, and the
12d Model xx entry removed from the Windows Registry.

The installation of the new 72d Model can now begin and the Welcome screen is displayed.

Welcome Welcome message

R

Welcome to the 12d Model 15 - 64 bit Setup Wizard

This wizard will guide you through the installation of 12d Model 15
- 64 bit.

It is recommended that you close all other applications before
starting Setup. This will make it possible to install without requiring
a system reboot.

Next > Cancel

Select Next > to continue with the installation
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Software License Agreement 12d Solutions license agreement

2@l 12d Model 15 - 84 bit Installation — *

12d Model End User License Acceptance

Please read the terms and conditions of use for 12d Madel. Installing this product is w
considered acceptance of this license.

12D Solutions Pty Ltd ~
Software License Agreement with Limited Warranty

Important - Read Carefully Before Installation and Use

This is alegal document and 15 an agreement between you (either an mdividual or an
entity) and 12D Selutions Pty Ltd. By opening the sealed software package and/or by
using the SOFTWARE. vou agree to be bound by the terms of this Agreement.

If vou do not agree to the terms of this Agreement, promptly return the disk package and
accompanving items (including anv hardware items. printed materials and binders or other ¥

[] I have read and accepted the tems of this Software License Pa.greemerD

Next = Cancel

If you agree with the License conditions, tick on I have read and accept the terms of the
Software License Agreement.

afl 12d Model 15 - 64 bit Installation — X

12d Model End User License Acceptance

Please read the terms and conditions of use for 12d Madel. Installing this product is m
considered acceptance of this license.

12D Solutions Pty Litd A
Software License Agreement with Limited Warranty

Important - Read Carefully Before Installation and Use

This is alegal document and is an agreement between you (either an individual or an
entity) and 12D Solutions Pty Ltd. By opening the sealed software package and/or by
using the SOFTWARE. vou agree to be bound by the terms of this Agreement.

If vou do not agree to the terms of this Agreement, promptly retum the disk package and

accompanying items (including any hardware items. printed materials and binders or other
( | have read and accepted the terms of this Software License A.greemerD
Mext = Cancel
Select Next > to continue with the installation
Documentation and What’s New Page 15
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Select Components

| i Gck on 12d Model to install 72d Model 15)

N
|

Gck on 12d Model Update Service to allow upgrade§

Select components

Select the components you would like to i i R . .
to be installed without being Administrator

|
-
( tick on Courses and Training to )

[ 12d Model g @stall some training and test data

12d Model Updater Service I

Courses and Trainin . . .
‘.. CodeMeter Hunﬁme% tick on CodeMeter Runtime to install
5 Microsoft Rurtimes the CodeMeter drivers

Microsoft Visual C++ Redistributable
Microsoft Visual C++ Redistributable 2008
M?cn:usu:nf't Visual C++ Hed?str?bl.rtable 2010 to install all the
Microsoft Visual C++ Redistributable 2012 Mi Redistri |

Microsoft Visual C++ Redistributable 2013 icrosoft Redistributables

Microgoft Visual C++ Redistributable 2015 2017 2019 |

[ |
tick on Microsoft Runtimes

< Back Mext Cancel

Tick on 12d Model to install 72d Model.

Tick on 12d Model Updater Service to allow the installation of 72d Model upgrades
without being logged in as Administrator.

Tick on Courses and Training to install training and test data.

Tick on CodeMeter Runtime to install the latest CodeMeter drivers.

Tick on Microsoft Runtimes if this is the first time you have installed 72d Model 15 on this
computer, and it will tick on all the Microsoft Visual C++ Redistributables.

Select Next > to continue with the installation
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Installation Location

R

Pick Installation Location

Select the location where you would like this application to be installed m

Setup will install this application in the following folder. To install in a different
folder, click Browse and select another folder.

Installation location:  |C:\Program Files'12d"\12dmodel15.00 Browse

Space required: 2.84GB

Space available: 600.48GB

< Back Next >

Continue with the default installation folder for the software:
C:\Program Files\12d\12dmodel\15.0
or click on Browse to browse to another folder for the installation

Select Next > to continue with the installation

User Area
ol 12d Model 15 - 84 bit Installation — e
Select User Area
Select the path where your User and User Lib folders will reside m
Target: |c:\12d4\15.00 Browse

< Back Next >

Continue with the default folder for the User Area for the software:
c:\12d\15.0

or click on Browse to browse to another folder for the User Area.

Select Next > to continue with the installation
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Ready to Install

ol 12d Model 15 - 84 bit Installation — e

Performing installation

Press Install to begin the installation.

< Back Install

Click on Install to begin the actual installation

The software will be copied and installed onto the computer.

ol 12d Model 15 - 84 bit Installation — e

L)

Performing installation

Extracting szip.dil -
Extracting szlibdll.dll

Extracting TUFLOW_AD_iDP_w6&4.dl
Extracting TUFLOW_AD_iSP_w&4.dll
Extracting TUFLOW_GPU_nDP_W&4.dl
Extracting TUFLOW_GPU_nSP_W&4.dl
Extracting TUFLOW_HPC_nDP_W&4.dl
Extracting TUFLOW_HPC_nSP_W&4.dll
Extracting TUFLOW _iDP_w64 exe
Extracting TUFLOW_jSP_w64 exe
Extracting TUFLOW_LINK_iDP_w64.dl

The Microsoft C++ Redistributables will be automatically installed

R}

Performing installation "
1 Microsoft Visual C++ 2012 Redistributable (86) - 11.0.51106 Setup | || = |[n25]

Microsoft Visual C++ 2012
Redistributable (x86) - 11.0.51106

Setup Progress

Extracting

Extracting Processing:  Initializing...
Extracting
Extracting
Extracting
Extracting
Extracting
Extracting
Extracting

Extracting
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DO NOT CLICK on anything on the Microsoft Redistributable panels, especially Cancel.
The panels will disappear by themselves.

Installation Complete
]

Installation for 12d Model 15 - 64 bit completed

12d Model 15 - 64 bit has been installed on your computer.

Click finish to close this setup wizard.

End of the installation. Select Finish to complete the installation

This completes the installation of the 712d Model software and CodeMeter drivers.

If you have not used a CodeMeter hardware lock on the computer before, then the CodeMEter
can now be attached to the computer. Go to Step 2. Attach the Dongle on page 19.

If you have already been using a CodeMeter hardware lock on the computer then go to Step 3.
SPECIAL NOTE ON CERTIFYING CODEMETERS on page 21.

Step 2.  Attach the Dongle

The 12d Model CodeMeter hardware lock can now be attached to the computer.
For USB dongles:

Warning: you must have System Administration rights the first time you
attach a USB dongle to any USB port:

When a USB dongle is attached for the first time to any USB port, Windows will detect that it
is new hardware and needs to load the dongle drivers for that USB port - this will require
System Administration rights.

Since the dongle drivers have already been loaded onto your computer, when the USB
dongle is attached to a new USB port, it will be recognised as new hardware

Found Mew Hardware

WIBU-BO=/RU

and Windows should automatically install the correct dongle driver.
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_\> WBL-BO=ARU

Inztalling ...

IMPORTANT NOTE IF THE CODEMETER IS NOT RECOGNISED:

If the CodeMeter hardware lock is not recognised you get the Found New Hardware screen

Found New Hardware Wizard

SO~ Welcome to the Found New
Hardware Wizard

Windows will search for current and updated software by looking
on your computer, on the hardware installation CD, or on the
Windows Update Web site (with your permission).

Read our privacy policy

Can Windows connect to Windows Update to search for
software?

(" Yes, this time only
(" Yes, now and every time | connect a device
(" No, not this time

Click Next to continue.

= Back [{ext = | Cancel |

please go to the section on how to find the Wibu drivers

NOTE - even though your CodeMeter is working on one USB port, if you try and attach the
CodeMeter to a new USB port, the CodeMeter drivers will need to be installed for the new
USB port. You will need System Administration rights to install the CodeMeter drivers on the
new USB port.

For 12d Model to run, the CodeMeter must be attached to the USB port at all times,
otherwise 72d Model will stop and ask you to save and exit.
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Step 3. SPECIAL NOTE ON CERTIFYING CODEMETERS

The 12d CodeMeters must communicate over the Internet with a Wibu Time Server every two
months to check that there is no problem with the CodeMeter that your 12d Model license is
using. This is called Certifying the CodeMeter.

For Certification to occur, a computer that can access the CodeMeter must also have access to
the Internet to run the Certification.

One month before the end of the two month period, 72d Model brings up the

Certify CodeMeter Dongle panel which gives the number of days, minutes and seconds remaining
until Certification is required.

If you are using a new CodeMeter from your 712d Model Reseller, then it will usually come
already Certified.

For more information on Certifying, see 5 Certifying CodeMeters on page 30.

12d Model will not function without an authorisation file called nodes.4d.

The final step is to install and test the nodes file. Go to Step 4. Installing the Nodes.4d file on
page 22.
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Step 4. Installing the Nodes.4d file
12d Model will not create new projects or open existing projects without an authorisation file
called nodes.4d with valid information in it.
The information inside nodes.4d controls
(a) which 12d dongles are authorised to run 12d Model
(b) what version of 12d Model will run for a dongle
(c) what modules are authorised to run for a particular 12d dongle

To authorise 12d Model to run with your 12d dongles, a file called nodes.12dxxn where xx is
the 12d Model version number, will have been emailed to you by your local 72d Model Reseller.

For example, for 12d Model 15 the file will be called nodes.12d15n

Subject: 12D Auth file for 12D Solutions - Lee; Product 12d Model - 5c2d47013c -
Attachments: | nodes.12dXXn (11 KB)

MNodes file for : 12D Solutions - Lee
- 5¢2d47013c -

The authorization file for 12d Model - is attached to this message.

The self-install procedure which follows is for this one workstation and requires 12dmodel installed.
After 12d Model version XX is installed, please double click on the file attachment [nodes.12dXXn] & to open it and 12d will guide you through.

If this succeeds you do not need to read further.

If this does not work it may be that the mail programme does not allow you to run attachments.
In this case, simply save the attached file to your desktop and open (from the right-mouse menu or by double-click).
This will start the installation for the nodes file.

Instructions for manual Installation:
For versionXX of 12d Model, usually goes in the folder
"12d\XX.00" and once there it must be renamed to "nodes.4d"

Codemeter dongles require a driver installation which can be obtained here
http://www.wibu.com/en/downloads-user-software.html

If the product is still not authorized after replacing or updating "nodes.4d"
please contact 12D Solutions on (61)(02) 9970 7117 or email support@12d.com

Installing 72d Model xx on a computer sets up a Windows file association so that a
nodes.12dxxn file is recognised and brings up the Install a 12d Model xx Nodes File panel which
is used is to install a nodes.4d file in the correct location.

In the email, double click on the files nodes.712dxxn and the Opening Mail Attachment panel
comes up.

Page 22 Documentation and What’s New

E— = = = ——— ————= = = = 72
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Subject: 12D Auth file for 12D Solutions - Lee; Product 12d Model - 5c2d47013c -
Attachments: | nodes.12dXXn (11 KB)

MNodes file for : 12D Solutions - Lee
- 5¢2d47013c -

The authorization file for 12d Model - is attached t{" . ] 57 N
Opening Mail Attachment

The self-install procedure which follows is for this g
After 12d Model version XX is installed, please dou

b ou should only open attachments from a trustworthy source,

If this succeeds you do not need to read further.
Attachment: nodes.12dXXn from 12D Auth file for 12D
Solutions - Lee; Product 12d Maodel - 5c2d47013c - -
Message (HTML)

If this does not work it may be that the mail progra
In this case, simply save the atipe ik

This will start the installationf’ click on\e-

Would you like to open the file or save it to your computer?

) \+ Open ] [ Save Cancel
Instructions .or manual Installation:

For versionXX of 12d Model, usually goes in the fo
"™12d\XX.00" and once there it must be renamed t

Always ask before opening this type of file

Codemeter dongles require a driver installation which can be obtained here
http://www.wibu.com/en/downloads-user-software.html

If the product is still not authorized after replacing or updating "nodes.4d"
please contact 12D Solutions on (61)(02) 9970 7117 or email support@12d.com

Click on Open and then the Install a 72d Model xx Nodes File panel appears

“f Install a 12d Model XX Nodes File - x

Install Manage

Source: |C MUsers'fred doofungles'App Data"-.Lu:u::al"-.l"-ﬂin:n:lsnﬂ"-.‘.".n'indcnws"'| i

Operation: Prepend >

Destination: ||: A12d' XX 00hnodes . 4d | I
Ins I Cancel

The choices for Operation are:

Prepend - if a nodes.4d file already exists, the information in the nodes.12dXXn file is added

to the beginning of the existing nodes file. A backup up copy of the existing nodes.4d is
created.

Replace - if a nodes.4d file already exists, it is replaced by a new nodes.4d file with the
information in the nodes.12dxxn file in the new nodes file. A backup copy of the existing
nodes.4d is created.

Append - if a nodes.4d file already exists, the information in the nodes.12dxxn file is added
to the end of the existing nodes file. A backup copy of the existing nodes.4d is created.

Select Replace, Append or Prepend and then click Install.

The new/updated nodes.4d file is created in the Destination folder (default is C:172d\xx.00) and
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if a nodes.4d file already existed, a backup copy of it is made.

12d Modes Installer oo

Modes update completed!
Old nodes backed up to: e\ 12dM12.000nodes.5.4d

OK

ﬂVote - if you don’t have the file nodes.12dxxn attached to an email but instead have the file in a \

o

folder accessible from your computer, then you can do the following:

If there is a nodes.12dxxn file, double click on that file and the Install a 12d Model Nodes File panel
should appear and you continue as per the instructions above.

If that doesn’t work, start up 72d Model xx and click on the Nodes.4d button at the bottom of the
Open a Recent Project panel. This will also bring up the Install a 12d Model Nodes File panel and you
can browse for the nodes.12dxxn file in the Source panel field. You can then continue as per the
instructions above.

/

CONGRATULATIONS - 12d Model has now been successfully installed.

The folders and icons that are created in the installation are given in the sections:

4.1 Folders Created by the Installation on page 26

4.2 Icons Created by the Installation on page 28,

If 12d Model did not install correctly and an Authorization Error panel came up, go to the section,
9 Errors Installing and Authorising on page 47, of these notes.

To obtain documentation for 72d Model, go to 6 Documentation on page 40.

Expanded Important Note on Nodes.12d15n and Nodes.4d
The 12d Model 15 nodes.12d15n file will normally be emailed to you.

During the installation of 72d Model 15, an association is created for files ending in .72d15n so
after the installation, opening the nodes.712d15n on the email will bring up the Install a 12d
Model Nodes File program which can copy the information in the nodes. 12d15n file to the
required area (normally C:\72d\15.00) and nodes.4d file.

If you do not have the nodes.12d15n attached to an email but instead have it in a folder and
have installed 72d Model 15, double clicking on the nodes.12d15n file will also bring up the
Install a 12d Model Nodes File program which can copy the information in the nodes. 12d15n
file to the required area (normally C:\72d\15.00) and nodes.4d file.

Or if the 12d Model 15 icon is clicked on, the Open a Recent Project panel comes up and clicking
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on the Nodes button will also bring up the Install a 12d Model Nodes File program which can
copy the information in the nodes. 72d15n file to the required area (normally C:\12d\15.00) and
nodes.4d file

Please do not change the name of the created nodes.4d file. 12d Model will only search for an
authorization file called nodes.4d.
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4.1 Folders Created by the Installation

4.1.1 C:\Program Files\12d\12dmodel\15.00

The 12d Model installation loads the 12d Model software into the folder
C:\Program Files\12d\12dmodel\15.00

12d Model users normally only have read access to the Program Files folders.

» This PC » Local Disk (C3) » Program Files » 12d » TZdmodel » 1500

-~
Mame

12dfield
T2dmodel
autocad
dda
dda_2d
dgn_x64
chuwg_x 64
s

e57

ey

12d Model software area under Program Files

faro
fhxtol2da
fop-1.0
graphwiewer
help
imagelzd
import
landzxrml
leica

library
rhacros
rito 6

pdf
pdfidwriter
pdftol2da
print

puhblic
redist
set_ups
tools
topcon
trirmble
wintileprint
xml

af uninstaller.exe
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4.1.2 C:\12d\15.00

The 12d Model installation also creates the folder:
C:\12d\15.00
which during the installation is given read/write access for the user.
If the Courses and Training component was ticked, then the installation will place some training

and testing data in the folders design and survey in the folder 12d\15.00 (or the folder you
selected)

Local Disk (C:) » 12d » 15.00 » training

Fat

Mame

design

survey

12d Model user areas

\_ /

The folder 12d\15.00 is also the default folder where the nodes.4d file with 12d Model 15
authorisations in it is installed:

C:\12d\15.00\nodes.4d

and is also the default area where a user creates their own subfolders User and User_Lib for
their user configurations of 12d Model.
Warning

An Uninstall will NOT delete any of the training material loaded into 12d\15.0\training and
12d\15.0\courses by a previous installation.

The 12d Model 15 Install will overwrite any files of the same name in these areas.



Installing12d Model

4.2 Icons Created by the Installation

The installation loads the appropriate components and creates the 72d Model 15 icon

B

12d Madel 15
- B4 Bit

icon for 12d Model 15 exe

The 12d Model 15 icon fire up 12d Model and attaches to the folder 712d\75.00.

4.3 Copying Existing User, User Lib and env.4d

If you have 712d Model 14 installed on your computer, then you will probably want the files in the
folders User and User_Lib, and env.4d to be used for 72d Model 15.

(@)

(b)

The folder User contains your files that are to replace those that 12d Model installs in
Set _ups (e.g. names.4d, linestyl.4d) and if you already have some, you will probably also
want to use them for 12d Model 15.

For 12d Model 14, the default place for User is ¢:\72d\74.00\User but it could also be
pointed to by the environment variable USER_4D.

If there is an existing User folder, you need to create a new User folder for 12d Model 15
and copy to it any files that you want for 12d Model 15.

The default place for the new User in 12d Model 15 is ¢:\12d\15.00\User but if USER _4D in
your V14 env.4d was used to point to your V14 User then you will need to change
USER_4D in your V15 env.4d to point to your V15 User folder

You may need to copy the whole of User to the new area.

The folder User_Lib contains your own library files and you will probably also want to use
them for 712d Model 15.

For 12d Model 14, the default place for User_Lib is ¢:\712d\14.00\User _lib but it could also
be pointed to by the environment variable USER_LIB_4D.

If there is an existing User_Lib folder, you need to create a new User_Lib folder for
12d Model 15 and copy to it any files that you want for 12d Model 15.

The default place for the new User_Lib in 72d Model 15 is c¢:\12d\15.00\User_Lib but if
USER _LIB 4D in your V14 env.4d was used to point to your V14 User_Lib then you will
need to change USER_LIB_4D in your V15 env.4d to point to your V15 User_Lib folder

You may need to copy the whole of User_Lib to the new area.
Setting Up Your env.4d File for 12d Model 14
The file env.4d contains environment variables that are used to customise 712d Model.

An env.4d file is installed it the Set_Ups folder when 12d Model is installed and if a user
wants to make any modifications to any of the environment variables in env.4d, then the
modified env.4d file is placed in the User folder.

So if you have an env.4d file in your User folder in 12d Model 14, you will probably also

Icons Create

]
<
=
Y
B
<}
=3
g
-~
s
3
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want to use it 72d Model 15.

The default location for your modified env.4d file in 12d Model 14 is in your User folder for
12d Model 14 so for 12d Model 15, you need to copy this env.4d file to your User folder in
12d Model 15.

(d) Are you using a 12d Network Lock ?

If you are setting up 712d Model to use a 12d Network CodeMeter for the first time, please
read the section 7 What's New in 12d Model 15 on page 45.

If you are using a 12d Network Lock (CodeMeter or Wibu) for 12d Model 14, then the file
dongles.4d which is in the User folder contains the information to tell 72d Model that it has
to search for a network lock, and possibly which computer the network lock is on.

So if you are using a 12d Network Lock for 12d Model 14, you will need to copy your
12d Model 14 dongles.4d file to the 12d Model 15 User folder.

4.4 End of the Notes for Installing 12d Model 15

This ends the detailed notes for installing 72d Model 15.

If you need to set up a Network CodeMeter, go to the section 10 Network CodeMeters on
page 51.

The links for downloading documentation on 72d Model are given in 6 Documentation on
page 40.

The links for downloading information, power points and videos on what is new in 72d Model 15
are given in 7 What's New in 12d Model 15 on page 45.

The rest of the chapters in this document are

5 Certifying CodeMeters on page 30

6 Documentation on page 40
7 What's New in 12d Model 15 on page 45
8 12d Model Training on page 46

9 Errors Installing and Authorising on page 47

10 Network CodeMeters on page 51
11 CodeMeter Control Center & WebAdmin on page 79
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5 Certifying CodeMeters

CodeMeters use the Certified Time capability of the CodeMeter and the CodeMeter must
communicate over the Internet with a certified Time Server every two months to check that
there is no problem with the CodeMeter, and to update the Certified time in the CodeMeter.

This process is called Certifying the CodeMeter.

Certifying a CodeMeter can be done
(a) manually from inside 12d Model itself

Already documented. See 5.1 Certifying CodeMeters from 12d Model on page 30
(b) automatically by 712d Model

Already documented. See 5.2 Automatically Certifying CodeMeters from 12d Model on
page 32

(c) outside of 72d Model when the CodeMeter is on the computer you are using outside

Using CodeMeter Control Centre - already documented in 5.3 Certifying CodeMeters
Using Control Center on page 33.

or

(d) outside 712d Model when the CodeMeter is NOT on the computer your are using

It is possible to certify CodeMeters that are on other computers but this is usually only
needed by Administrators. See 11.3.1 Certifying CodeMeters Using WebAdmin on page 89

5.1 Certifying CodeMeters from 12d Model

One month before the end of the two month period, 12d Model will bring up the Certify
CodeMeter Dongle panel which gives the number of days, minutes and seconds remaining until
Certification is required.

il Certify CadeMeter Dongle — >

Container 3.t testa_bed@fred.com

Clock time  |3025-06-09 22:09:33
System time  |3025-06-09 22:09:17
Boxtime  |2025-06-09 22:06:25
Certify tirne  [3025-06-05 22:09:45

Warnings fwarnings will begin in 26 days 0 hours O minutes 27 seconds

Countdonn  |needs to be certified within the next 58 days 0 hours 0 minutes 27 seconds

Certify | Cradust Finish Help

The Certify CodeMeter Dongle panel can also be brought up from within 72d Model by the option

Project =>Management =>Dongles =>Certify CodeMeter
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The Certified time for that CodeMeter is updated to the current date by clicking on the Certify
button.

Important Note

There is an environment variable AUTO_CERTIFY_DONGLE_4D and if it is set on then when
the warning period is active for the CodeMeter (dongle) being used by 12d Model, 12d Model
will automatically attempt to certify the CodeMeter and if successful, no intervention by the user
is required. See 5.2 Automatically Certifying CodeMeters from 12d Model on page 32.
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5.2 Automatically Certifying CodeMeters from 12d Model

12d Model can automatically attempt to certify the CodeMeter whenever it is within the warning
period (within one month of the two months after the Certified Time).

If the environment variable AUTO_CERTIFY_DONGLE_4D to 1, whenever 12d Model is started
up, then if it is in the warning period 12d Model will automatically attempt to certify the dongle.
And if successful, no user intervention is required.

The environment variable AUTO_CERTIFY_DONGLE_4D is set by the Edit Environment
Variables panel. which is brought up by the Projects =>Management =>env.4d option.

-

i Edit Environment Variables

=-Env.dd General

- Files & Folders |
- Projects
- Dongles [

H- Elements

H- CAD

- Plotting

- Drainage

- MTF & Boxing
-~ Tunnel

H- Views

b GUI

- Warnings and Error Reporting
- GIS

- External Apps
-Wariables

-

General |

]
vlte E

Gutn certify Codemeter

i Wibu (deprecated)

o y | Search for field | Search| |Prev.| |Mext

Finish

Please contact your 12d Model Reseller if you are having problems certifying your CodeMeter.

Note

Any computer which has the environment variable AUTO_CERTIFY_DONGLE_4D set to 1 can
certify the Network CodeMeter that it is using to obtain a license from a 12d dongle.

Please contact your 12d Model Reseller if you are having problems certifying your CodeMeter.
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5.3 Certifying CodeMete

rs Using Control Center

The Certified Time for any CodeMeter attached to your current computer can be

displayed by using the CodeMeter Control Center which is brought up by clicking a
on the CodeMeter icon that was installed on your task bar.

The CodeMeter Control Center shows any CodeMeters that are attached to the this computer.

-
@ CodeMeter Control Center

2 |

License Events Borraw

License Update

@ CmStick Name:
2-2310262

Serial:

Version:

Capadity:

Status:

2-2310262

&
CmStick 2.04
93 % free (367400 Bytes)

@ @ Disabled
5] (& Enabled until unplugged

@ Enabled
Eject Change Password

CodeMeter is started.

The Certified Time in a CodeMeter that is on this computer can be displayed and updated by
clicking on Process >Update Time Certificates

& CodeMeter Control Cente

‘_ Update Time Certificates
(= (&) Repair Hardware Configuration Name:

(¥) Start CodeMeter Service
@ Stop CodeMeter Service

Serial:

Version:

Capacity:

Status:

License Update

CmsStick 2.04

2-2310278
93 % free (367432 Bytes)

@ Disabled
] (2 Enabled until unplugged

@ @ Enabled |
Eject Change Password

CodeMeter is started.

[ =

s

Certifying CodeMeters Using Control Center Page 33

= = = e o= e 7 X
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Note

If the CodeMeter is not on the computer you are using the then certifying the codemeter must be
done using CodeMeter WebAdmin (see 11.3.1 Certifying CodeMeters Using WebAdmin on

page 89).
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5.4 Installing the CodeMeter Drivers Separately

For some reason you may want to install the CodeMeter drivers separately to the 12d Model
installation. In that case you only need to download the CodeMeter Drivers which is downloaded
from:

https://downloads.12dmodel.com/v15/12d_Model 15_C1t/CodeMeterRuntime 8 20.exe

WARNING You need to have System Administrator rights to install the CodeMeter drivers

Once you have downloaded the CodeMeter Drivers exe, click on it to begin the installation
process.

Note: If clicking on the link does not start up your Browser then copy the text of the link into your
Browser.

Installing the CodeMeter Drivers:

The script to install the CodeMeter drivers begins.

CodeMeter Setup ~ CodeMeter Runtime Kit Setup
|8 CodeMeter Runtime Kit v8.20 Setup = *

Welcome to the CodeMeter Runtime Kit !
v8.20 Setup Wizard |
Runtime Kit v8.20 features are installed on your computer or

9

The Setup Wizard allows you to change the way CodeMeter
to remave it from your computer. Click Next to continue or

Cancel to exit the Setup Wizard. |

SYSTEMS

B

Back Cancel

Select Next to continue.
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End-User License Agreement CodeMeter Runtime Kit Setup

End-User License Agreement

Please read the following license agreement carefully

'WIBU-SYSTEMS AG, Karlsruhe, Germany and Wibu-Systems USA Inc.,
Edmonds, WA, USA I
Software License Agreement, Single Use License

CodeMeter and WibuKey Software

PLEASE READ THIS SOFTWARE LICENSE AGREEMENT ("LICENSE™)
BEFORE USING THE SOFTWARE. BY USING THE SOFTWARE, YOU
ARE AGREEING TO BE BOUND BY THE TERMS OF THIS LICENSE. IF
YOU ARE ACCESSING THE SOFTWARE ELECTRONICALLY, SIGNIFY
YOUR AGEEEMENT TO BE BOUND BY THE TEEMS OF THIS LICENSE
BY CLICKING THE "AGREE/ACCEPT" BUTTON. IF YOU DO NOT
AGEEE TO THE TERMS OF THIS LICENSE, RETURN THE WIBU-

(ﬂl accept the terms in the License Agreement )

Print Back Cancel

Read the License Agreement and if you are happy with it,
tick "l accept the terms in the License Agreement" and then select Next to continue.

Installation Scope CodeMeter Runtime Kit Setup

‘ Installation Scope
Choose the installation scope and folder

User name: |E

[
‘ Organization: |Design Without Pain
|
|
|
|

() Install just for you (lig.admin)

CodeMeter Runtime Kit vo. cu wm ve niialled in a per-user folder and be available
just for your user account. You do not need local Administrator privileges.

© Install for all users of this machine

CodeMeter Runtime Kit w8, 20 will be installed in a per-machine folder by default
and be available for all users. You can change the default installation folder. You
must have local Administrator privileges.

Enter your User name and Organisation.

Click on either Install just for you or Install for all users of this machine
and then select Next to continue.

Page 36 Installing the CodeMeter Drivers Separately
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Custom Setup

-

Custom Setup
Select the way you want features to be installed.

Click the icons in the tree below to change the way features will be installed.

hard drive.

m

Reset Disk Usage Back

Select Next to continue.

Ready to Install

Ready to install CodeMeter Runtime Kit v8.20

Click Install to begin the installation. Click Back to review or change any of your
installation settings. Click Cancel to exit the wizard.

Back Install

=]

CodeMeter Runtime Kit Setup

B CodeMeter Runtime Kit This features installs the CodeMeter
MNetwork Server Runtime Kit on your computer,
WibushellExtensior
User Help

AUtomatic SErVer S| yhic faatire requires 137MB on your hard
Remote access to drive. It has 2 of 5 subfeatures selected.
The subfeatures require 34MB on your

w
m

Cancel

CodeMeter Runtime Kit Setup

Cancel

Select Install to continue.
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Installing CodeMeter Runtime Kit Setup

Installing CodeMeter Runtime Kit v8.20

Please wait while the Setup Wizard installs CodeMeter Runtime Kit v8.20.

Status: Updating component registration
I ——

Completed CodeMeter Runtime Kit Setup

T CodeMeter Runtime Kit v8.20 Setup = *

Completed the CodeMeter Runtime Kit
v8.20 Setup Wizard

Clidk the Finish button to exit the Setup Wizard.

WiBU

SYSTEMS

P
m

Select Finish to end.

Note: A CodeMeter icon, that is used to bring up the CodeMeter Control Center, is also installed
on your task bar.

Important Notes
. Do not attach a hardware lock to your computer until after the appropriate driver is installed
2. The CodeMeter drivers need to be at least version 6.3.

If your computer already has drivers installed and they are NOT at least version 6.3, when
12d Model 15 starts it will stop and complain that the hardware lock drives are NOT up to

Installing the CodeMeter Drivers Separately

— = = = = =
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If that is the case then
(a) Uninstall the existing CodeMeter drivers
(b) Install new CodeMeter drivers. See 5.4 Installing the CodeMeter Drivers Separately.

If you were installing the CodeMeter drivers as part of setting up a Network CodeMeter, go to _
What is Done to the Computer By Step 1.

After CodeMeter drivers have been installed, the CodeMeter can be attached to the computer.
Go to Step 2. Attach the Dongle.
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6 Documentation

See

6.1 12d Model Reference Manual on page 40

6.2 12d Model Programming Language Manual on page 42

6.4 12dxml File Format on page 43
6.5 12da File Format on page 44
7 What's New in 12d Model 15 on page 45

6.1 12d Model Reference Manual

The 12d Model Reference manual contains the technical information required for using
12d Model includes information such as:

(a) the tools and concept used in 12d Model
(b) descriptions of the 72d Model screen layout, views and toolbars

(c) information on each 72d Model menu

(d) technical information on the fields in each 72d Model panel

(e) information on all the set up files for 72d Model. For example, for colours and linestyles
(f) information on the 12d XML and 12da file formats

(g) information on the 712dfield and fld file formats

Although the 712d Model Reference manual contains some information on each of the fields in
panels, it is the technical information about what is valid values etc and is not intended to be a
full description on how all the options work together. That is, it is NOT a training manual.

The 12d Model Reference manual also acts as a context sensitive Help system when
12d Model is running.

That is, when 72d Model is running:

(a) for most menus in 72d Model, when the menu is on the screen and has the Windows focus,
pressing F1 will open the 12d Model Reference manual at that menu

(b) for most panels in 12d Model, when the panel is on the screen and has the Windows focus,
pressing F1 will open the 712d Model Reference manual at that panel. Or if the panel has a
Help button, clicking on the Help button opens the 712d Model Reference manual at that
panel.

The full 12d Model Reference manual is can be accessed from within 72d Model by clicking on
the option Help =>12d Model.
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Help n

About 12d Model

Aythorization details

GEd Fodel Reference manual)

12d Macro Manual

What's Mew

What's Mew Summary
Training

12d on the WWeb L
Ernail info to 12d

Dongles

Check for updates

Systerm Information

ser »

The 12d Model Reference is a pdf file and when 12d Model is installed, it is copied into the
Help folder.

< Local Disk (C3) » Program Files » 12d » 12dmodel » 1500 ¢ help

2
Marme

12d.pdf
12d_8,_File_Format.pdf
12d_Field_File.pdf

12D_PROGM pdf

12d_Wiew.pdf
12d_¥ML_File_Farmat.pdf
12dm_getting_started_for_design.pdf
12drm_getting_started_for_surveying.pdf
Projection_Traverse_Spreadsheet.pdf
Whats_Mew_in_12d_adelpdf

(1 2d Model Reference manuaD

To download a zipped copy of the12d Model Reference manual,12d.pdf, click on the following
link and then unzip the downloaded file

https://downloads.12dmodel.com/v15/12d_Model 15 _C1t/12d.zip

Note: If clicking on the link does not start up your Browser then copy the text of the link into your
Browser.

Continue to 6.2 12d Model Programming Language Manual or return to 6 Documentation.
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6.2 12d Model Programming Language Manual

The 12d Model Programming Language (12dPL), is a powerful programming language
designed to run from within 72d Model. It is also known as 4DML from when the product was
called 4d Model.

Its main purpose is to allow users to enhance the existing 12d Model package by writing their
own programs. These programs are often called macros.

The 12d Model Programming Language manual is a reference manual and does not try to
teach programming techniques. Instead this manual sets out the syntax, restrictions and
supplied functions available in 12dPL.

The 12d Model Programming Language manual is a pdf file and can be downloaded from
within 72d Model by clicking on the option Help =>12d Macro Manual.

Help n

Ahout 12d Model
Auythorization details
12d Model Reference manual
GEd kacro kanual )
Nhat's MNew
Wrhat's Mew Summary
Training

12d on the \Web »
Ernail info to 12d

Dangles

Check for updates

Systern Inforrmation

User r

To download a pdf copy of the 72d Model Programming Language manual 12d_prog.pdf
outside of 12d Model, click on the following link

https://downloads.12dmodel.com/v15/12d_Model 15 _C1t/12d_progm.pdf

Note: If clicking on the link does not start up your Browser then copy the text of the link into
your Browser.

Continue to 6.3 12d Field File Format or return to 6 Documentation.
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6.3 12d Field File Format

The 12d Field File Format manual contains the documentation of the 72d Model raw survey file
format .712dfield, and the older raw survey file format, .fld.

The 12d Field File Format is part of the 12d Model Reference manual (see 6.1 12d Model
Reference Manual) but the chapter as also been separated out so the entire 72d Model
Reference manual is not needed.

To download a pdf copy of the 12d Field File Format manual, click on the following link

https://downloads.12dmodel.com/v15/12d_Model_15_C1t/12d_Field_File Format.pdf

Note: If clicking on the link does not start up your Browser then copy the text of the link into
your Browser.

Continue to 6.4 12dxml File Format or return to 6 Documentation.

6.4 12dxml File Format

The 12dxml file format is a text file definition from 12d Solutions which is used for reading and
writing out string data from 72d Model. 12dxml files normally end in .712dxml.

The 12dxml file is a Unicode file.

The documentation for 12dxml is part of the 12d Model Reference manual (see 6.1 12d Model
Reference Manual) but the chapter as also been separated out so the entire 12d Model
Reference manual is not needed.

To download a pdf copy of the 72d Model 12dxml manual, click on the following link

https://downloads.12dmodel.com/v15/12d_Model 15 C1t/12d_xml_File Format.pdf

Note: If clicking on the link does not start up your Browser then copy the text of the link into
your Browser.

Continue to 6.5 12da File Format or return to 6 Documentation.
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6.5 12da File Format

The 12da (12d Archive) file format is a text file definition from 72d Solutions which is used for
reading and writing out string data from 12d Model. 12da files normally end in .12da.

The 12da file is a Unicode file.

The documentation for 12da is part of the 12d Model Reference manual (see 6.1 12d Model
Reference Manual) but the chapter as also been separated out so the entire 12d Model
Reference manual is not needed.

To download a pdf copy of the 12da File Format manual, click on the following link
https://downloads.12dmodel.com/v15/12d_Model_15_C1t/12d_A_File_Format.pdf

Note: If clicking on the link does not start up your Browser then copy the text of the link into
your Browser.

Further Notes:

1. 12da was originally an Ascii file and stood for 12d Ascii but now that the 72da file is a
Unicode file, 12da stands for 12d Archive.

2. 12da has now been superseded by 12d xml (see 6.4 12dxml File Format)

Continue to 7 What's New in 12d Model 15 or return to 6 Documentation.
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7 What’s New 1n 12d Model 15

This chapter contains links to information on many of the new things in 72d Model 15.

See
7.1 What's New pdf on page 45
7.2 What's New Summary of All Additions on page 45
7.3 What's New Summary of Additions Sorted by Sub-Version on page 45

7.1 What's New pdf

The What’s New in 12d Model 15 pdf gives detailed information on many of the new options
and features in 12d Model 15.
https://downloads.12dmodel.com/V15/12d_Model 15 _C1t/Whats New_in_12d_Model.pdf

Note: If clicking on the link does not start up your Browser then copy the text of the link into
your Browser.

7.2 What's New Summary of All Additions

A one line summary of all the additions in 72d Model 15, sorted by Component:

https://downloads.12dmodel.com/V15/12d_Model_15 C1t/WNS in_12d_Model All.htm

Note: If clicking on the link does not start up your Browser then copy the text of the link into
your Browser.

7.3 What's New Summary of Additions Sorted by Sub-Version

A one line summary of all the additions and fixed bugs in 12d Model 15, broken into sub-
versions and subsorted by Components:

https://downloads.12dmodel.com/V15/12d_Model_15_C1t/WNS in_12d_Model_subsort.htm

Note: If clicking on the link does not start up your Browser then copy the text of the link into your
Browser.

Continue to 8 12d Model Training or return to 6 Documentation.
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8 12d Model Training

There are a variety of 72d Model training courses available including:

(a) Instructor Led Online Public Training

This training is conducted over Teams and is led by an Instructor. Courses from beginners to
advanced are available on all aspects of 712d Model.

12d Model licences are provided for the training.
The Public courses are open to anyone.
(b) Instructor Led Online Training for One Company

This training is conducted over Teams and is led by an Instructor. Courses from beginners to
advanced are available on all aspects of 72d Model.

12d Model licences are provided for the training.

The One Company courses are restricted to those students nominated by the company
booking the course.

(c) Self Paced Online Training (SPOT)

This training is conducted online but their is no Instructor. The student works throw a series
of videos and questions. 12d Model licences are provided for the training.

There are FREE and chargeable SPOT courses.
The SPOT courses are open to anyone.
(d) Face to Face Public Training

This training is conducted face-to-face by an Instructor. Courses from beginners to
advanced are available on all aspects of 72d Model.

12d Model licences are provided for the training.
The Public courses are open to anyone.
(e) Face to Face Inhouse Training for the One Company

This training is conducted face-to-face by an Instructor. Courses from beginners to
advanced are available on all aspects of 72d Model.

12d Model licences are provided for the training.

The One Company courses are restricted to those students nominated by the company
booking the course.

For more information, see https://www.12d.com/training/index.html and/or
https://www.civilandsurveying.com

Return to 7 What's New in 12d Model 15.
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9 Errors Installing and Authorising

See
9.1 12d Model XX Not Authorising on page 47
9.2 Licence Expiry Warning on page 48

9.3 Dongle Missing on page 49

9.1 12d Model XX Not Authorising

If there is an error with the installation, then the Error Authorizing Release Version panel appears
with the error messages in the panel message area.

For example, for 12d Model XX

- T - -
ufl, Authorization Error

12d Model XX

Summary |Auth0rizati0n details | Dongle administration |

An error occurred while authorizing this copy of 12d Model!

Date  21-10-14 17-2342 A valid Company means that a nodes.4d file has

Company 12D Solations - Lee been read and there is a VXX entry in it

User lig
-« hodes.4d file found and being used
Nodes.4d file found c:\12d\ xx.00\nodes.4d

no 12d dongle detected
12d Model tried to login to the following dongles

Dongle Type III::::E] g Search location Status
New dongle codemeter_auto_local dongle| UNKINOWN |Local Computer § silocdreatiens fond

[What to try next?

Check the "Authorization details" tab for errors

Make sure any local dongles are plugged in.

Make sure the computer can see all local dongles. (Did vou plug the dongle into a different USB port?)
Make sure the local service is running.

Only your local computer was searched. Do you have a network dongle that needs to be configured?

DR

Installation messages
and error messages area 2

| Running msinfo32.exe in the backgreund, so no need to wait until it finishes! \

Projects Dongles Envdd | | Quit Email support| Help |

In the above panel, the UNKNOWN in the Dongle number column shows that no 72d dongle
has been detected.




Installing12d Model

If there is no error message on the panel or it is still not obvious what the problem is, please
contact your 12d Model Reseller.

9.2 Licence Expiry Warning

The nodes.4d file that controls 712d Model, only validates 12d Model to run for a certain period
of time.

If when running 72d Model, the Licence Expiry Warning panel appears:

"# Licence Expiry Waming ‘ ﬁ

The current licence finishes in 14 days (Thursday, June 18, 2015) at 23:59

If you have entered a new code further down in the file,

it will be used when this one expires

You may wish to make the new one current now to test it

(oK)

L"gh S —

it simply means that the nodes.4d file needs to be updated.

Please contact your 12d Model Reseller to obtain a new nodes file before the given date. If this
is not done then 72d Model will no longer run until you do obtain and install a new nodes file.
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9.3 Dongle Missing

If when running 72d Model, the Dongle Missing panel appears:

Dangle Missing

Dongle administration

#- All Dongles I

[ Locking for dengle /

[  Retry || Dongleretry |[Saveandexitizd|| Edt12d |

it simply means that the 72d dongle can no longer be seen by 712d Model.

Please check that your 12d dongle is still attached to your computer, or if you are using a
network dongle, that your network is still active.

Then click on Retry, and if that doesn’t work, click on Dongle retry.

Even if you still can not see the dongle, 72d Model will allow you to save your current work so
that nothing is lost by clicking on the Save and exit 12d button.






10 Network CodeMeters

A 12d Local CodeMeter (also known as a Standalone or single-user CodeMeter) is a
CodeMeter that is attached to a computer that only allows 72d Model to be run on that
computer.

If the 712d Local CodeMeter is to be used on another computer then the 12d Local CodeMeter
must be moved to the other computer. This means that 12d Model will no longer run on the
computer without the 12d Local CodeMeter.

This is the default installation for 12d Model.

A 12d Network CodeMeter is a CodeMeter that controls a number of 712d Model licenses and
the 12d Network CodeMeter can potentially be accessed by any other computer on the
network, and allows copies of 12d Model to be run on those computers without needing a 712d
Local CodeMeter.

The 12d Model licenses controlled by the 712d Network CodeMeter can be accessed and used
in any country and any time zone, subject to any Australian and local Laws that may prevent it.
The only restriction is that each instance of 72d Model on a computer requires its own

12d Model license from the 12d Network CodeMeter.

12d Network CodeMeters are metallic and a silver colour, and are labelled with a number
starting with ec.

/12d Network CodeMeten
Silver USB

Note: When using a 12d Network CodelMeter, each running copy of 712d Model using a 12d
Network CodeMeter on a computer requires a license from the 12d Network CodeMeter.

If your computer is not using a 12d Local CodeMeter and is only using a 12d Network
CodeMeter to obtain 12d Model licenses then 72d Model and the CodeMeter Drivers still need
to be installed on the computer that is wanting to run 72d Model.

BUT when 72d Model is installed it is set up for users with a Local (single user or stand alone)
CodeMeter and installs a dongles.4d file that assumes that 12d Model is only using a 12d
Local CodeMeter and has no access to a 12d Network CodeMeter.

So to access a 12d Network CodeMeter, the dongles.4d file needs to be modified and the
nodes.4d file you use will need to contain an authorization for the 72d Local CodeMeter.

Note: a computer can be set up to look for both a 72d Local CodeMeter and a 12d Network
CodelMeter.

To install the Network CodeMeter and configure computers to use the Network CodeMeter, you
will need
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1. First Install the CodeMeter drivers
IMPORTANT WARNING

Do not attach any CodeMeters, Network or Standalone, to your computer until after you have
installed the CodeMeter Drivers.

The latest CodeMeter Drivers installation program is downloaded from:
https://downloads.12dmodel.com/v15/12d_Model_15_C1t/CodeMeterRuntime_8_20.exe

For the notes for installing the CodeMeter Drivers separately, see 5.4 Installing the CodeMeter
Drivers Separately on page 35.

2. anodes.4d file to authorize the 12d Model xx licenses controlled by the 12d Network
CodeMeter where xx is the 12d Model versions required.

This is usually supplied in an email a the attached file nodes.12dxxn (for example, for
12d Model 15, it will be nodes.12d15n)

Or you may already have it in a folder with the 12d Model authorization file nodes.12dxxn or
nodes.4d in it.

Full instructions setting up Network CodeMeters, and making the required modifications to the
dongles.4d file and the nodes.4d file, are given in the rest of this chapter.

Continue to 10.1 Definitions and Guide to the Network Notes on page 53.
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10.1

Detinitions and Guide to the Network
Notes

A 12d CodeMeter Server is a computer with a 12d Network CodeMeter attached to it. Note that
this can be any computer, it does not have to be a Server Computer.

A 12d CodeMeter Client is a computer that gets its 712d Model licenses from a 12d CodeMeter
Server. The CodeMeter Client computer does not have a 12d Network CodeMeter attached to it.

-

-

~

<CodeMeter Client)
<C0deMeter Cliem‘)

(CodeMeter Client)
CodeMeter Server <C0deMeter Client>
computer with a
Network CodeMeter 3
(CodeMeter Client\ CCodeMeter Cltent>
J CodeMeter Server
computer with a
Network CodeMeter| <C0deMeter Client>
(CodeMeter Client) CCodeMeter Client)

(CodeMeter Client)
CodeMeter Client Computers Networked to One or More CodeMeter Server Computely

Both CodeMeter Servers and CodeMeter Clients must have the CodeMeter Drivers and
CodeMeter Runtime Server service installed and running and this is described in 10.2 Installing
CodeMeter Drivers on page 55.

CodeMeter Servers must also have the CodeMeter Network Server running and this is
described in Step 6. Starting the 12d Network Server on page 63.

To run 12d Model on a CodeMeter Client, an appropriate dongles.4d and valid nodes.4d file
must be obtained and set up. This is describing in 10.4 dongles.4d and nodes.4d on page 65.

These notes are for
(a) Installing and setting up a new 12d Network CodeMeter to act as a 12d License server

(b) Setting up other computers (Clients) so they can access the Network CodeMeter and
12d Model licenses in the 12d Network CodeMeter.

(c) Setting up/Updating dongles.4d to instruct the other computers (Clients) which Network
CodeMeters to use. This can be down to the level of using a particular virtual 72d dongle
inside a particular 12d Network CodeMeter.

(d) Setting up/Updating the nodes.4d file with the authorization to match the 12d dongle being
accessed inside a 12d Network CodeMeter.

(e) Updating the 12d Model licenses in a 12d Network CodeMeter

(f) Monitoring 12d Network CodeMeters.
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WARNING

If the computers accessing a 12d Network CodelMeter are in a different subnet (behind a
router) to the 72d Network CodeMeter then 12d Model needs to be given the IP address or the
computer names of the servers with the 712d Network CodeMeter. This will be explained later in
the notes. This will also apply to computers connected by Wireless or DHCP.

If you already have a 12d Network CodeMeter and are simply updating a 712d dongle inside the
Network CodeMeter, go to the section 11.5 Updating Licenses in Network CodeMeters on

page 111.

if your are installing a 12d Network CodeMeter on the computer for the first time, please
continue to the next section 10.1 Definitions and Guide to the Network Notes on page 53.

Important Note for Going From 12d Local CodeMeters to 12d CodeMeter Servers

The CodeMeter drivers are exactly the same ones that are used for a 12d Local (standalone or
single-user) CodeMeter. So if a computer is already been used for a 12d Local CodeMeter with
12d Model, then the CodeMeter drivers have already been installed and will not need to be
installed again.

This means that if a 12d Network CodeMeter is introduced, all the computers that are currently
running 72d Model with a Local CodeMeter will not need the CodeMeter drivers installed.

However, such CodeMeter Client computers will need a modification to their dongles.4d file to
tell the computer that 72d Model licenses can be obtained from a 712d Network CodeMeter
rather than just a 12d Local CodeMeter (see 10.4 dongles.4d and nodes.4d on page 65).

Also a valid nodes.4d file for the 12d dongle inside the 712d Network CodeMeter is needed
(see 11.5 Updating Licenses in Network CodeMeters on page 111).
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10.2 Installing CodeMeter Drivers

IMPORTANT WARNING - Do not attach a 12d CodeMeter to your computer until after you have
installed the CodeMeter drivers.

This section is installing the CodeMeter drivers.

This must be done on the computer that will have the 12d Network CodeMeter attached to it (the
CodeMeter Server) and also for all the computers that are 12d CodeMeter Clients using the
CodeMeter Server.

If the computer has no CodeMeter Drivers, or old CodeMeter Drivers, installed on it, go to 5.4
Installing the CodeMeter Drivers Separately on page 35.

If a computer is to become a CodeMeter Sever but already has the CodeMeter Drivers installed
on it, then go straight to 10.3 Setting up a 12d Network CodeMeter on page 58.

If the computer is already set up as a CodeMeter Server and you are adding a new 12d dongle
to the 12d Network CodeMeter, or upgrading the number of 12d licenses on a 12d dongle in the
12d Network CodeMeter, go to 11.5.1.1 Updating Using the .WibuCmRaU File on page 115.

If you are replacing the existing 12d Network CodeMeter by a new 12d Network CodeMeter, go
to 11.6 Replacing an Existing Network CodeMeter on page 119.

Installing CodeMeter Drivers Page 55
e = = = > <= 7 —Z
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What is Done to the Computer By Step 1

1. CodeMeter Drivers

The CodeMeter drivers that allows software to access CodeMeters anywhere on the network is
installed.

2. CodeMeter Runtime Server

The service CodeMeter Runtime Server service is also installed and started on the computer
and if you look in the Services tab of the Windows Task Manager, the CodeMeter Runtime
Server will be shown as Running.

158 Windows Task Manager

File

Options  View Help

| Applications | Processes | Services | performance | Metworking | Users |

-

Name PID Description Status Group

dr_optimization_v4.0.30319_64 Microsoft .MET Framework NGEM v... Stopped M

CodeMeter.exe 12464 CodeMeter Runtime Server Running M
Yot T S ya e Appieaaan )] 8] ]2 TR

If for some reason the CodeMeter Runtime Server is shown as Stopped, to restart it again go
to Step 6. Starting the 12d Network Server on page 63.

3. CodeMeter Icon

As well as installing the CodeMeter drivers., a CodeMeter icon is installed on
your task bar

Clicking on the CodeMeter icon brings up the CodeMeter Control Center which shows any
CodeMeters that are attached to the this computer. The CodeMeter Control Center also has
options to stop and start the CodeMeter Runtime Server and bring up the WebAdmin panel to
examine the content of CodeMeters anywhere on the network.
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’ ~
@ CodeMeter Control Center Y
License Events Borrow
@ CmStick Mame:

2-2310262

Serial: 2-2310262

€ ©

Veersion: CmStick 2,04

Capacity: 93 % free (367400 Bytes)

Status: @) @Disabled

(2 (g Enabled until unplugged

@ Enabled
License Update Eject Change Password
CodeMeter is started. WebAdmin
\ .

If the computer is to be a CodeMeter Server, then the next step is to check the Network
CodeMeter. If this is the case then go to 10.3 Setting up a 12d Network CodeMeter on page 58.

If the computer is a CodeMeter Client, then the next steps are to

(a) set up the dongles.4d file to see the 12d Network CodeMeter (and if required a particular
12d dongle inside the 12d Network CodeMeter)

and
(b) set up the nodes.4d with the authorization for the required 12d dongle number.

For setting up dongles.4d and nodes.4d, see 10.4 dongles.4d and nodes.4d on page 65.
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10.3 Setting up a 12d Network CodeMeter

The CodeMeter drivers are now installed and the CodeMeter Runtime Server is running.

The next steps are to actually attach the 12d Network CodeMeter, examine its contents to make
sure everything that are correct, and then start up the 12d Network Server so that other
computers in the network will be able to see and use the 12d Network CodeMeter.

These steps will complete the setting up of the 12d Network CodeMeter as a 12d CodeMeter
Server.

Step 2.Attaching the Network CodeMeter

The physical CodeMeter number can be found on the part of the 12d Network CodeMeter that
is pushed into the USB port (the CodeMeter shaft). The number starts with 2-.

This number needs to be recorded but you need to have very good eyes to be able to read it or
have a magnifying glass.

If the CodeMeter number can’t be read, it is also possible to obtain the number after the 12d
Network CodeMeter is plugged into the USB port of the computer (see Step 3. Checking that the

12d Network CodeMeter is Visible on page 59.)

a 12d Network CodeMeter - Silver USB I

CodeMeter number N%

£

Bny
\ - _.-l".;'II /

Now that the CodeMeter drivers are installed on the computer, the 12d Network CodeMeter can
now be attached to the USB port on the computer.

Page 58 Setting up a 12d Network CodeMeter
= = = L 7 X
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Step 3.Checking that the 12d Network CodeMeter is Visible

Click on the CodeMeter icon that was installed on your task bar —— g
to bring up the CodeMeter Control Center which shows what
CodeMeters are on this computer.

@ CodeMeter Control Center S

License Events Borrow

@ CmStick

Mame:
2-2310262

Serial: 2-2310262

@ B [~

Version: CmStick 2.04

CodeMeter number
Capacity: 93 % free (367400 Bytes)

Status: @ @Disabled

() \&y Enabled until unplugged

@ Enabled
License Update Eject Change Password
CodeMeter is started. WebAdmin

e

A

The CodeMeter number, that is written on the shaft of the CodeMeter, should be displayed in the
CodeMeter Control Center.

Step 4.What to Do If You Can’t See the CodeMeter

If you were unable to see the CodeMeter number in the CodeMeter Control Center then first
check that the service CodeMeter Runtime Server service is installed and running on the
computer by looking in the Windows Task Manager and checking that CodeMeter Runtime
Server is shown as Running.

18 Windows Task Manager

File Options View Help

| Applications | Processes | SEMVices | Performance | Metworking | |Jsers |

=
MName PID Description Status Group
dr_optimization_v4.0.30319_64 Microsoft \MET Framework NGEM v... Stopped M/
CodeMeter.exe 12464 CodeMeter Runtime Server Running MA
TS YEERE T Sy e ter Appea tan e ]a [T} TR

If for some reason the CodeMeter Runtime Server is there but shown as Stopped, to restart it
again see Step 6. Starting the 12d Network Server on page 63.

If you are still having problems then contact your 72d Model Reseller.
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Step 5.Checking the Virtual 12d Virtual Dongles Inside the Network CodeMeter
The 12d Network CodeMeter alone is not enough to provide a license to run 72d Model.
There must also be a 12d virtual dongle inside the Network CodeMeter.

Itis the 12d virtual dongle that controls how many network licenses of 12d Model are.available.

Aside:

The 12d virtual dongle issues the 712d Model licenses but the actual 12d Model modules
that go with a license from a 12d virtual dongle is controlled by a matching entry in the
nodes.4d file. This means that what 712d Model modules you have can be updated by just
adding a new entry for the nodes.4d file. The word virtual is used because the 12d virtual
dongle is NOT a physical lock. The 12d virtual dongle is often abbreviated to 12d dongle.

Clicking on the WebAdmin button on the CodeMeter Control Center brings up the CodeMeter
WebAdmin panel which is used to display information about any of the CodeMeters that it can
see. Note - you may have one of two versions of WebAdmin - see 11.8 Which Version of
WebAdmin? on page 120.

For WebAdmin 6:

Clicking on the tab Content >Licenses of the CodeMeter WebAdmin panel displays the
12d virtual dongle information stored in the selected CodeMeter.

<« ¢ o @ build-server.12d.com:22350/container/emcontainer_details.html?BoxSerial= see [# mn o =

CodeMeter WebAdmin C

SYSTEMS

Dashboard Container v License Monitoring v  Diagnosis ¥  Configuration v  Info

E All Container <no name> (2-2310233) (2] B English (US) ~
P <no name> 2-2310233 CmStick 2.04 @
7
X% A Licenses CmContainer Info Backup & Restore

A 100003 Bundling Articles

Product Code Name Unit Counter Valid Until License Quantity Feature Map
1 SecurikKey Lite nfa nfa 1 0x1

A 101956 12d.com

Product Code Name Unit Counter Valid Until License Quantity Feature Map
1 12d Model - Stock - 12d Solutions - ec51470113 nfa nfa 5 nfa
1 12d Model ec51470114 nfa nfa 25 nfa

Current Server: BUILD-SERVER (192.168.68.252) % i WebAdmin Version: 6.4/)

12d Product name 12d virtual dongle number Total number of licenses on
12d Customer name the 12d virtual dongle

For instructions on how to select and see CodeMeters on a particular 12d Network Server,
see 11.4.1 Getting Info on CodeMeters on a Particular Server - WebAdmin 6 on page 98

For WebAdmin 5:

Clicking on the tab Content >Licenses of the CodeMeter WebAdmin panel displays the
12d virtual dongle information stored in the selected CodeMeter.
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CodeMeter WebAdmin C‘v]
LT content arver  Configuration Diagnosis Info Help

CmContainer Licenses User Data Backup/Restore

CmContainer: [2-2310262 [v]

100003 | Bundling Articles

Product A Unit Expiration Activation License
Code Counter Time Time Quantity
1 Securikey Lite nfa n/a n/a 1

101956 | 12d.com

Product Name Unit Expiration Activation License
Code Counter Time Time Quantity
12d Mode! Q2 Solutions )
1 nfa n/a n/a 3
/ﬂ ec51470022 N >
12d Product name 12d Customer name Total number of licenses on
the 12d dongle

12d virtual dongle number

For instructions on how to select and see CodeMeters on a particular Network Server, see
11.4.3 Getting Info on CodeMeters on a Particular Server - WebAdmin 5 on page 105

If there are no 12d dongle numbers displayed inside the 12d Network CodeMeter, or no 12d
dongle number starting with ec, contact your 72d Model Reseller.

You need to make a note of the 12d dongle number because there must be a valid entry with
the matching 12d dongle number in the nodes.4d file.

Note: The WebAdmin button is only selectable if the CodeMeter Runtime Server is running. If
it is Stopped, to restart it again see Step 6. Starting the 12d Network Server on page 63.

Important Note:

There may be more than one 12d dongle number inside the one physical CodeMeter
Container. That is why they are also referred to as virtual 12d dongles. For example,
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- @ WebAdmin | Container b + - O
e

CodeMeter WebAdmin C

SYSTEMS

Dashboard Container v License Monitoring v Diagnosis ¥+ Configuration v Info

E All Container <no name> (2-2310233) (2] B English (US) ~
&; <no name:> 2-2310233 CmStick 2.04 .
C\
%, A Licenses CmContainer Info Backup & Restore
Number of licenses on
C two 12d dongle numbers in the CodeMeteO each 12d dongle

Counter Valid Map

1 SecunXeNLite nfa n/a 1 Ox1

A 101956

Product Code Name Unit Counter WValid Until License Quantity Feature Map
1 12d Model - St - 12d Solutions - ec51470113 nfa n/a 5 Infa
1 12d Model - Stock - 12d Solutions - ec51470114 nfa nfa 25 Infa

Current Server: BUILD-SERVER (192.168.68.252) % : WebAdmin Version: 6.40

(& Q‘ @ build-server.12d.com:22350/container/ecmcontainer_details.html?BoxSerial= e @ ﬁ In @ =

Within 72d Model, it is possible to address specific 12d Network CodeMeters, and specific 12d
dongles within a 12d Network CodeMeter. This is done via the dongles.4d file and how it is set

up is described in 10.4.1.2 Updating dongles.4d Using the Dongles.4d Editor on page 68.

Page 62 Setting up a 12d Network CodeMeter

e —— "~

——— —_——_ S — —— == —
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Step 6.Starting the 12d Network Server
For a 12d Network CodeMeter to be seen and used by other computers in the network, the 12d
Network Server needs to be running on the computer with the 12d Network CodeMeter on it.
The CodeMeter WebAdmin panel is used to start the 12d Network Server.

Note: The 12d Network Server is controlled by the CodeMeter Runtime Server service so it is
critical that the CodeMeter Runtime Server service is running.

To bring up the CodeMeter WebAdmin panel, click on the WebAdmin button on the CodeMeter
Control Center.

For WebAdmin 6:
In the CodeMeter WebAdmin panel, click on the Configuration >Server >Server access

menu.
- & WebAdmin | Server Access b + - O
&« ( ‘@‘ ® localhost:22350/configuration/server_access.html e 1:? N @
CodeMeter WebAdmin C
SYSTEMS

Dashboard Container ~  License Monitoring v  Diagnosis v~
E Server Configuration Server Access Basic 5 (2] B English (US)
Server Access License Access Permissions (Server >| Server Access )
—Network Server Advanced License Access Permiss
O Disable
MNetwork Port *: 22350

—CmWAN Server
O Disable

® Enable
CmMWAN Port *: 22351 |

Apply Restore Defaults

(*) Changes only take effect after restarting CodeMeter

Click on Enable and then Apply.
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For WebAdmin 5:

In the CodeMeter WebAdmin panel, click on the Configuration >Server tab and then tick on

Run Network Server.

CodeMeter WebAdmin C\/J

| Home Content Server [LUMHLLIL" Diagnosis Info Help

Network Server Proxy Access Control Certified Time WebAdmin Backup Borrowing

Server
Bind Address: All (Default)
Run Network Server: [
Network Port =: |2235E}I
Run CmWAN Server: [
CMWAN Port =: [22351 |
Apply || Default

(*) Changes only take effect after restarting CodeMeter

Click on Apply and a message Operation completed successfully - please wait will
appear and when it disappears, the above panel is displayed again.

The 12d Network Server should now be running.

Note that unlike the CodeMeter Runtime Server service, the 12d Network Server is not a
service and so will not appear in the Windows Task Manager.

The computer with the 12d Network CodeMeter is now ready to use as a 12d CodeMeter
Server.
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10.4 dongles.4d and nodes.4d

For 12d Model to be able to create and/or open existing projects, it requires

(a) alicense from a 12d dongle inside a 12d Network CodeMeter

and

(b) a valid entry with the matching 12d dongle number in the nodes.4d file

Once dongles.4d and nodes.4d have been updated, they must be the nodes.4d and

dongles.4d files that are used for any computer wanting to use a 72d Model license from the
12d Network CodeMeter.

For updating dongles.4d, see 10.4.1 Modifying the dongles.4d file on page 65.

For updating nodes.4d, see 10.4.2 Installing a nodes.12d15n File on page 76.

10.4.1 Modifying the dongles.4d file

The dongles.4d file lists the computers to search for 12d Network CodeMeters, 12d Local
CodeMeters and 12d Local Wibu dongles to find 12d dongle numbers.

It also defines the order to search for CodeMeters and Wibus.

When 12d Model is installed on a computer, it installs a dongles.4d file that is configured to only
look for Local (standalone) CodeMeters and Local Wibus.

For each computer that needs to access to a 12d Network CodeMeter, a modification has to be
made to the dongles.4d file used by that computer to tell 72d Model to search for a 12d
Network CodeMeter and not just use a 72d Local CodeMeter.

The updated dongles.4d is then placed in the standard search path for a set up file for that
computer and the particular version of 72d Model. For example, for 12d Model 15, the
dongles.4d could be in c:\12d\15.00\User. Or it uses a file pointed to by the environment
variable DONGLES_4D in env.4d. This means that the dongles.4d file could be on the one
central computer and accessed by all the other computers.

Important Note

In the initial 72d Model installation, the dongles.4d file is a set up file and is installed in the
Set_ups folder under the 72d Model version number.

For example, for 12d Model 15
Program files\12d\12dmodel\15.00\Set_ups

All the files in Set_ups are supplied by 12d Solutions and must not be modified. Hence in
updating the default dongles.4d file, the procedures outlined will modify a copy of the
dongles.4d file.

The editing of dongles.4d does not have to be on the computer that the 12d Network
CodeMeter is on. It can be done from any computer.

There are two ways that the dongles.4d file can be modified:
1. Using the Dongles.4d Installer program on a dongles.12d15d file

If 12d Model is V15 C1m or later, then during the installation an association has been set up
for *.12d15d files to file up the Dongles.4d Installer program. See 10.4.1.1 Installing using
the dongles.12d15d file on page 66.
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2. Updating the dongles.4d file using the Dongled.4d Editor

The dongles.4d file can also be updated using a text editor. See 10.4.1.2 Updating
dongles.4d Using the Dongles.4d Editor on page 68.

10.4.1.1 Installing using the dongles.12d15d file

When 12d Model xx is installed, a Windows file association is created so that a *.72dxxd file is
recognised and it brings up the Install a 12d Model xx Dongles File panel which is used is to
update a dongles.4d file with the dongles information in the .72dxxd file.

So to update your dongles.4d file, a file called dongles.12dxxd where xx is the 12d Model
version number, will be emailed to you by your local 12d Model Reseller.

For example, for 12d Model 15, the file is called dongles.12d15d

Emailing: dongles.12d15d

Lee John Gregory

LJ

° To @ Lee John Gregory

dongles.12d15d
3KB

L

In the email, double click on the files dongles.12dxxd and the Opening Mail Attachment panel

comes up,
0 =
h dong
i & KB dongles.12d15d -
8 KB
L=rsr Opening Mail Attachment I} *
= Open
l} o You should only open attachments from a trustworthy source,
C Quick Print
Attachment: dongles.12d15d from Emailing: dongles.12d15d
Ff Save As - Message [Plain Text)
|r[§] Save All Attachments...
Waould you like to open the file or save it to your computer?
> Remove Attachment
(B Copy
Always ask before opening this type of file
ER Select Al
Clicking on Open brings up the Install a 72d Model xx Dongles File panel.
Page 66 dongles.4d and nodes.4d
————— ~

E— = = = ——— ————= = = = 72
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W Install a 12d Model XXDongles File — >

Imstall Manage

Source: |C:'-.12|:| 415,00 wser'dongles. 12d15d | =
Cperation: Prepend =
Destination: |:::'-.12d'-.)(X,I]'D'-.Llser'-du:ungles.ﬂd | |

Prepend - if a dongles.4d file already exists, the information in the dongles.12dXXs file is
added to the beginning of the existing dongles file. A backup up copy of the existing
dongles.4d is created.

The choices for Operation are:

Replace - if a dongles.4d file already exists, it is replaced by a new dongles.4d file with the
information in the dongles.12dxxd file in the new nodes file. A backup copy of the existing
dongles.4d is created.

Append - if a nodes.4d file already exists, the information in the nodes.12dxxd file is added to
the end of the existing dongles file. A backup copy of the existing dongles.4d is created.

Select Replace, Append or Prepend and then click Install.

The new/updated dongles.4d file is created in the Destination folder (default is
C:\12d\xx.00\User) and if a dongles.4d file already existed, a backup copy of it is made.

12d Dongles Installer >

Dongles update completad!
Old dongle backed up to: c\12dW15.000serdongles.1.4d

For the updating of nodes.4d, see 10.4.1.2 Updating dongles.4d Using the Dongles.4d Editor on
page 68.
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10.4.1.2 Updating dongles.4d Using the Dongles.4d Editor

To edit the donges.4d file using the Dongles.4d Editor, start up the Project Launcher for

12d Model BUT it is not necessary to open a 712d Model project. The current dongles.4d file
can be edited by simply starting up 72d Model by clicking on the 12d 15 icon to bring up the
Project Launcher:

P Project Launcher - *

D = ® O |

Last Opened Recent New Open Settings

OCOEH®®

Clicking on Settings displays the Start-up Settings panel and then click on the dongles.4d editor
icon to bring up the Dongles.4d Editor panel.

PP Start-up Settings - *

Configuration file $USER\env_configs.4d O
Defauit environment configuration @
Defauit dongis configuration @
Defguit thems @
Defauit theme size @
ONONIENCN
Note:
Page 68 dongles.4d and nodes.4d
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Or if the 12d Model you are running is already authorised and you are in an open project, you
can access the Dongles.4d Editor by picking the option

Projects =>Management =>Dongles =>Dongles.4d editor
Both methods bring up the Dongles.4d Editor panel.

If the dongles.4d is the one installed with 72d Model then it will only be looking for Local
(standalone) CodeMeters and Local (standalone) Wibus:

-

Add a new entry

\

i Dongles.4d Editor - *

\‘ﬂ Delete ﬂ

Codemeter Local Type Codemeter - Auto L...
Wibu Local Mame Codemeter Local
N Active true =4
-::':lnlfr @
# retries ]

Wait time (seconds) 0.01

List of CodeMeter
and Wibu dongles to
search for.

They are searched
for in the order in this
list.

| is valid

What it needs in the list is an entry to tell 72d Model to look for your 12d Network CodeMeter.

To Add a new entry to dongles.4d, click on the Add button which then bring up the
Add a New Dongle panel.

-

P Add a new dongle = 2
Type |Codemeter - auto network [_;]l
| Select Choice @
— Wibu - local and auto local
[Add ] [F'”'s‘h] [HEIP‘] Wibu - network
Wibu - auto network

Codemeter - local
Codemeter - auto local
Codemeter - network
Codemeter - auto network
Pause

To add an entry to search for all Network CodeMeter on the network, see 10.4.1.2.1 Search for
any 12d Network CodeMeter on page 70.

To add an entry to use a particular 12d dongle number in a particular 12d Network CodeMeter,
see 10.4.1.2.2 Using a 12d Dongle Number in a 12d Network CodeMeter on page 73.
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10.4.1.2.1 Search for any 12d Network CodeMeter

The simplest entry to add is the one that searches for all 12d Network CodeMeters on the

network.
P Add a new dongle = 2
Type |Codemeter - auto network [_;]l
| Select Choice @
Wibu - local and auto local
[Add ] [Finish] Wibu - network

Wibu - auto network
Codemeter - local
Codemeter - auto local
Codemeter - network

|-
Codemeter - auto netwu:ur@

Pause

For this case, select CodeMeter - auto network for Type and then click on Add.
A new entry with the default name New dongle is added to the bottom of the list.

i@ Dongles.dd Editor

Add | Delete ﬂﬂ
Codemeter Local

Wibu Local

M Filt
FUL

Type
MName
Active

# retries

Wait time (seconds)

— x

Codemeter - Auto ..
MNew dongle
true

-
LT

0.01

| is valid

Write

Finich

Click in the Name field and change New dongle to whatever you want, say CodeMeter - auto

network.

The order in the list is the order that 712d Model searches to find a valid dongle.

For example if you want to always search for a local dongle BEFORE the 12d Network
CodeMeter then leave the order as it is.
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il Dongles.dd Editor

ﬂ Delete ﬂ

Codemeter Local

Wibu Local

Codebdeter - auto network

Type
Mame
Active

=
n

T =

FLLEr

# retries

Wait time (seconds)

Codemeter - Auto ...
CodeMeter - auto n...
true v d
g
0

0.01

This is what is normally wanted. That is, use a local dongle if it exists, otherwise use a network

license.

If you want to always search for a 12d Network CodeMeter BEFORE a local dongle then use
the Up arrow icon to move the CodeMeter - auto network to the top of the list. This is rarely

wanted.

il Dongles.dd Editor

_hdd | Ddlae| & w]

CodeMeter - auto network Type Codemeter - Auto ...
Codemeter Local Mame CodeMeter - auto n...
Wibu Local Active true 7
ibu Loca —
FITEr @
Z retries ]
Wait time (seconds) 0,01
To save the information to the dongles.4d file, press Write to bring up the
Write Setup Flle "dongles.4d" panel.
i@ Write Setup File "dongles.4d” — >

(" Found folder

" Current folder

{» Uszerfolder

ch12d\ 14,000 user

(" Other folder

|E:"-.-—h:I_u:In:u:umentaticn"-.'l 2d_¥14.00 Doco12d_Model_14_Projects\DE

Write

Properties

Help

Tick on User folder and then on Write.

For any computer wanting to use a 72d Model license from a 12d Network CodeMeter, the

dongles.4d and nodes.4d
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updated dongles.4d must be placed in the standard search path for the User folder, or in the
folder pointed to by the environment variable USER_4D in env.4d, or is the file pointed to by the
environment variable DONGLES_4D in env.4d.

Using DONGLES_4D means that the dongles.4d file could be on a central computer that can
be accessed by all the other Client computers.

Note:

If you don’t want to search for a Local dongle at all. simply highlight the Local entries and click
on the delete icon to delete them.

WARNING

Projects can have a local dongles.4d file and when the project is selected, the local dongles.4d is
used before any other dongles.4d. If the local file does not have the correct network information
in it then the authorization will fail because 12d Model is no longer being instructed to use the
Network CodeMeter.
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10.4.1.2.2 Using a 12d Dongle Number in a 12d Network CodeMeter

To point to a particular 12d dongle number, it helps to know the physical CodeMeter number
that the 12d dongle number is in.

If you don’t already know this, the CodeMeter WebAdmin panel can be used to look inside the
Network CodeMeter. See Step 5. Checking the Virtual 12d Virtual Dongles Inside the Network
CodeMeter on page 60.

Note: if you still don’t know what Network CodeMeter the 12d dongle is in, it is possible to find it
when using the Dongles.4d Editor but you will need to look through the list of physical
CodeMeter numbers and see which one contains the required 12d dongle number.

In the Add a New Dongle panel, for the case of using a particular 12d dongle number, select
CodeMeter - network for Type and then click on Add.

-

i Add a new dongle = P
Type |Codemeter - auto network E]l
| Select Choice @
— Wibu - local and auto local
[Add ] [F'”'S‘h] [HEIF"] Wibu - network
L Wibu - auto netwaork

Codemeter - local
Codemeter - auto local
Codemeter - network )
Codemeter - auto network
Pause

A new entry with the default name New dongle is added to the bottom of the list.

i~ !

i Dongles.4d Editor = 2

@ CodeMeter icon

Wibu Local Type Codemeter - Network
Codemeter Local Mame
Active =
New dongle SEeryer name @
# retries ]

Wait time (seconds) 001

Click in the Name field and change New dongle to whatever you want but it helps to have the
12d dongle number in the name. For example CodeMeter - ec51470022

Next click on the CodeMeter icon at the end of the Server name field.

This will bring up the CodeMeter Browse panel that searches for all the 12d Network CodeMeters
on the network and for all the 12d dongle numbers in them, and presents the results in a tree.
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-

ifl CodeMeter Browse

k=]

-

s =

[=I- Server Containers
= Fred.12d.com’

[=- 101956

licensequantity(3)
L. checkoutduration(l)

= Larry.12d.com
EI 2-2310233
. =-101956

&) 2-2310262 physical CodeMeter numbe
2= -

r

-

4 T

| feBD::a486:b165:933:e547%21,/2-2310278/1

Scroll down the tree until you find the 12d dongle number you are after and click on it.

This will then write what is called the CMUNC to the Server name field.

Aside:

CMUNC is the 12d CodeMeter Universal Naming Convention. An example would be

/[server_name.12d.com/2-2310242/1/16

where server_name is the server name (Fred) with .12d.com added to it, followed by CodeMeter
serial number (2-2310242), then the product code (1), and the final part being the instance within

that product code that contains the 12d dongle number.

Note: The instance can only be found by using the CodeMeter Browse panel.

To save the information to the dongles.4d file, press Write to bring up the

Write Setup Flle "dongles.4d" panel.
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W Write Setup File "dongles.4d" — .

~ Found folder
" Current folder

i+ Lser folder
o\ 12d4 14,00 user

" Other folder
|E:' 4d_documentation'12d_V14.00_Doco'12d_Model_14_Projects\DE

Write | Properties Finish | Help

Tick on User folder and then on Write.

For any computer wanting to use a 12d Model license from a 12d Network CodeMeter, the
updated dongles.4d must be placed in the standard search path for the User folder, or in the
folder pointed to by the environment variable USER_4D in env.4d, or is the file pointed to by the
environment variable DONGLES_4D in env.4d.

Using DONGLES_4D means that the dongles.4d file could be on a central computer that can
be accessed by all the other Client computers.

WARNING

Projects can have a local dongles.4d file and when the project is selected, the local dongles.4d
is used before any other dongles.4d. If the local file does not have the correct network
information in it then the authorization will fail because 72d Model is no longer being instructed
to use the 12d Network CodelMeter.

For the updating of nodes.4d, see 10.4.2 Installing a nodes.12d15n File on page 76.




Installing12d Model

10.4.2 Installing a nodes.12d15n File

12d Model will not create new projects or open an existing project without an authorisation file
called nodes.4d with valid information in it.

The information inside nodes.4d controls

(a) which 12d dongles are authorized to run 72d Model
(b) what version of 12d Model will run for a 12d dongle

(c) what modules are authorized for a particular 12d dongle

To authorize 12d Model to run with your 12d dongles, a file called nodes.12dxxn where xx is
the 12d Model version number, will have been emailed to you by your local 12d Model Reseller.

For example, for 12d Model 15 the file will be called nodes.12d15n

Cc
Subject: 12D Auth file for 12d Solutions- €c7239002

-] Message | " nodes.12d15n (21 KB}

Modes file for : 12d Solutions
- ec7239002

The authorization file for 12d Model - is attached to this message.

The self-install procedure which follows is for this one workstation and requires 12d Model installed.
After 12d Model version 15 is installed, please double click on the file attachment [nodes.12d15n] to open it and 12d will guide you through.

If this succeeds you do not need to read further.

If this does not work it may be that the mail programme does not allow you to run attachments.
In this case, simply save the attached file to your desktop and open (from the right-mouse menu or by double-click).
This will start the installation for the nodes file.

Instructions for manual Installation:
For version 15 of 12d Model, nodes.12d15n usually goes in the folder
"12d\15.00" and once there it must be renamed to "nodes.4d"

Codemeter dongles require a driver installation which can be obtained here
http://www.wibu.com/en/downloads-user-software.html

If the product is still not authorized after replacing or updating "nodes.4d"
please contact 12D Selutions on (61)(02) 9970 7117 or email sales@12d.com

Installing 72d Model on a computer sets up a Windows file association so that a nodes.72dxxn
file is recognised brings up the Install a 12d Model xx Nodes File panel which is used is to install
a nodes.4d file in the correct location.

In the email, double click on the files nodes.72dxxn and the Opening Mail Attachment panel
comes up.
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Cc
Subject: 12D Auth file for 12d Solutions - ec7239002

-] Message | " nodes.12d15n (21 KB}

Modes file for : 12d Solutions
- ec7239002

The authorization file for 12d My . .
Opening Mail Attachment >

The self-install procedure which

After 12d Model version 15 is ins o You should only open attachments from a trustworthy source, [ Buide you through.

If this succeeds you do not need |

Attachment: nodes. 12d15n from 120 Auth file for 12d
Solutions - COVID-19; Product 12d Model - ec514700f5 -
ec514701el - - Message (HTML)

If this does not work it may be th

In this case, simply savp”™

This will start the instf ClicK on

Open \Wnuld you like to open the file or save it to your computer?

Instructions for manual Installati

For version 15 of 12d Model, not Always ask before opening this type of file
"™12d\15.00" and once there it m

Codemeter dongles require a driver installation which can be obtained here
http://www.wibu.com/en/downloads-user-software.html

If the product is still not authorized after replacing or updating "nodes.4d"
please contact 12D Selutions on (61)(02) 9970 7117 or email sales@12d.com

Click on Open and then the Install a 12d Model xx Nodes File panel appears.

‘I_J Install 2 12d Model 15 Modes File — 4

Install Manage

Source: |C:'-.Users'-Jjg.radon.‘l2D'-J’-\.ppData'-.Lu:ncal'-.Microsnﬂ'—-.‘ﬂu'indows'-.Ir~| =

Operation: Prepend il

Destination: |c:'-.1 2d%15.00%odes 4d | =
Install Cancel

The choices for Operation are:

Prepend - if a nodes.4d file already exists, the information in the nodes.12dxxn file is added
to the beginning of the existing nodes file. A backup up copy of the existing nodes.4d is
created THIS IS THE NORMAL CHOICE.

Replace - if a nodes.4d file already exists, it is replaced by a new nodes.4d file with the

information in the nodes.12dxxn file in it. A backup up copy of the existing nodes.4d is
created.

Append - if a nodes.4d file already exists, the information in the nodes.12dxxn file is added
to the end of the existing nodes file. A backup up copy of the existing nodes.4d is created.
THIS IS RARE.

Select Prepend, Replace or Append and then click Install.

The new/updated nodes.4d file is created in the Destination folder (default is C:172d\xx.00) and
if a nodes.4d file already existed, a backup copy of it is made.

dongles.4d and nodes.4d Page 77
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12d Modes Installer =

Modes update completed!
Old nodes backed up to: cy12d415.00nodes. 3.4d

ﬁ\lote - if you don’t have the file nodes.12dxxn attached to an email but instead have the file in a \

folder accessible from your computer, then you can do the following:

If there is a nodes.12dxxn file, double click on that file and the Install a 12d Model Nodes File panel
should appear and you continue with the instructions above.

If that doesn’t work, start up 12d Model xx and click on the Nodes.4d button at the bottom of the
Open a Recent Project panel. This will also bring up the Install a 12d Model Nodes File panel and you
can browse for the nodes.12dxxn file in the Source panel field. You can then continue with the

wstructions above. /

For any computer wanting to use a 712d Model license from a 12d Network CodeMeter, the
updated nodes.4d is then placed in the standard search path for the User folder.

For example, for 12d Model 15 a nodes.4d in c:\12d\15.00, or a file pointed to by the
environment variable AUTHORIZATION_4D in env.4d.

Using AUTHORIZATION_4D means that the nodes.4d file can be on a central computer and
accessed by all the other Client computers.

Now that the dongles.4d file and the nodes.4d file have been updated, any computer on the
network that has the CodeMeter drivers installed and has the updated dongles.4d and nodes.4d
file should be able to obtain a 72d Model license from a Network CodeMeter. That is, it becomes
a 12d CodeMeter Client.

This ends the notes for setting up the 12d CodeMeter Server and any 12d CodeMeter Clients.
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11

CodeMeter Control Center & WebAdmin

The CodeMeter Control Center is used on a particular computer to display which CodeMeters
are on the computer the Control Centre is being run on, to stop and start the CodeMeter
Runtime Server service on the computer, Certify CodeMeters on the computer and to update
the contents of any CodeMeters on the computer. It can also bring up the CodeMeter
WebAdmin panel.

The CodeMeter WebAdmin can do whatever the Control Centre can do but it can work on
CodeMeters on ANY computer that are visible on the network and it has permission to access.

To bring up the CodeMeter Control Center, click on the >

CodeMeter icon that was installed on your task bar. (0
@ CodeMeter Control Center £
License | Events | Borrow
CrStick .
® avirm e

Serial: 2-2310262

€ @ [

Version: CmStick 2.04

Capacity: 23 % free (367400 Bytes)

Status: @ @Disabled

) (g Enabled until unplugged

® @ Enabled

License Update Eject Change Password

CodeMeter is started. J)

A

Options under the Process menu can start and stop the CodeMeter Runtime Server service on
the computer. See 11.1 Stopping & Starting the CodeMeter Runtime Server on page 80)

The License Update button is for reporting on, and updating the information about 72d Model
licenses for any CodeMeter (Network or Standalone) attached to this computer. See 11.5
Updating Licenses in Network CodeMeters on page 111).

The WebAdmin button brings up the CodeMeter WebAdmin panel which can display information
about 12d Model licenses for any CodeMeter (Network or Standalone) that is visible on the
computer network. See 11.8 Which Version of WebAdmin? on page 120.
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11.1 Stopping & Starting the CodeMeter Runtime Server

Some changes to CodeMeter configurations on a computer require that the CodeMeter
Runtime Server service is restarted on the computer. In these cases, there is usually a message
to say Changes only take effect after restarting CodeMeter.

The stopping and starting of the CodeMeter Runtime Server on a particular computer can be
done from running CodeMeter Control Center on that computer, or WebAdmin can be used to
stop and start the CodeMeter Runtime Server on any computer that is has access to and
adequate permissions.

See

11.1.1 CodeMeter Runtime Server - Control Centre on page 81
11.1.2 CodeMeter Runtime Server - WebAdmin on page 84
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11.1.1 CodeMeter Runtime Server - Control Centre

Click on the CodeMeter icon that was installed on your task bar —— g
to bring up the CodeMeter Control Center. a

Clicking on the WebAdmin button on the CodeMeter Control Center brings up the CodeMeter
WebAdmin.

For WebAdmin 6:

To stop the CodeMeter Runtime Server service, click on Process >Stop CodeMeter Service
in the CodeMeter Control Center.

@ CodeMeter Control Centor e — - L&J

View Help

Lio O Defragment License Memories |

| ) Update Time Certificates
G @ Repair Hardware Configuration MName:

k) Start CodeMeter Service

©Q Stop CodeMeter Service

Serial: 2-2310262

© © &

Viersion: CmStick 2.04

Capadty: 93 % free (367400 Bytes)

Status: () @Disabled

0 (& Enabled until unplugged

@ @ Enabled
License Update Eject
CodeMeter is started. WebaAdmin

You will be asked to confirm that this is to be done.
The CodeMeter Control Center will then reappear with no CodeMeters being found on the

computer and if you look in the Windows Task Manager, the CodeMeter Runtime Server
service will be shown as Stopped.

-
E-_WindowsTaskManager - - A s FFwYTYYTEESE TS

File Options View Help

| Applications | Processes | Services |Performan0e I MNetworking I Users |

i
MName PID Description Status Group
U _Dpramieauor_v=e UL oo I3 05 L |1 § L@JI LW HNET TTGTTEWRTR THWEEN W o LU KIS
CodeMeter.exe CodeMeter Runtime Server Stopped N,M)

OGS ysApD LM T System AppIcaton Stopped TR

To start the CodeMeter Runtime Server service, click on Process >Start CodeMeter Service
in the CodeMeter Control Center.



Installing12d Model

r -
@ CodeMeter Control Center - — - M

File

View Help

Lid & Defragment License Memaories

it Update Time Certificates

No CodeMeter License information available.

(#) Repair Hardware Configuration There are no CmContainers found.

Q Start CodeMeter Service

(m) Stop CodeMeter Service

CodeMeter is stopped. WebAdmin

s — — = = —

You will be again be asked to confirm that it is to be done.

After a short time, the CodeMeter Control Center panel will then reappear displaying the
CodeMeters on this computer.

(& CodeMeter Control Center | 28

License Ewvents Borraw

@ CmStick Name:
2-2310262

Serial: 2-2310262

Version: CmStick 2.04

GRER

CodeMeter number
Capadity: 93 % free (367400 Bytes)

Status: @ @Disabled
(2 (2 Enabled until unplugged
© (& Enabled

License Update Eject Change Password
CodeMeter is started. Webadmin

e 4

If you look in the Windows Task Manager, the CodeMeter Runtime Server service will be shown
as Running.
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"B Windows Task Manager

File Options View Help

| Applications IProcesses Services | Performance | Metworking | Users |

MName . PID Description Status Group

cr_ontimization w40 30319 &4 Microsaft NET Framesuork MEEN w_ Stogned KA

CodeMeter.exe 124964 CodeMeter Runtime Server Running M/
L Yot ] T Dyaten Appnea o ) o8] ]3] Tom

Note: There may be more than one CodeMeter attached to the computer. For example

@ CodeMeter Control Center ﬁ

File Process View Help

: CodeMeter numbers
License | Events Borrow | —~

o CmStick Name:
2-2310262

Serial: 2-2310262

Version: CmStick 2.04

© B

Capacity: 93 % free (367400 Bytes)

Status: @ (&) Disabled

(@] (& Enabled until unplugged

] @ Enabled
License Update Eject Change Password

CodeMeter is started. WebAdmin

Warning: Access to all the CodeMeters on the computer is stopped by stopping the CodeMeter
Runtime Server service.
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11.1.2 CodeMeter Runtime Server - WebAdmin

To bring up the CodeMeter WebAdmin panel, click on the WebAdmin button on the CodeMeter
Control Center.

For WebAdmin 6:

For instructions on how to select and see CodeMeters on a particular Network Server, see
11.4.1 Getting Info on CodeMeters on a Particular Server - WebAdmin 6 on page 98

Once the required Computer is selected in the CodeMeter WebAdmin panel, to stop the
Network Server, click on the Configuration >Server >Server access menu, then select
Disable and finally click on Apply.,

- & WebAdmin | Server Access b + - O
e

c ‘@‘ ® localhost:22350/configuration/server_access.html e 1:? N @

CodeMeter WebAdmin C

SYSTEMS

Dashboard Container ~+  License Monitoring v  Diagnosis v [E@elsjile[sg-1uls]s 1%

E Server Configuration Server Access Basic 5 (2] B English (US)
Server Access License Access Permissions ( Server > Server Access )
—Network Server Advanced License Access Permiss
@ Disable
O Enable

—CmWAN Server
O Disable

® Enable
CmMWAN Port *: 22351 |

‘ Apply ) Restore Defaults

(*) Changes only take effect after restarting CodeMeter

The CodeMeter Control Center will then reappear with no CodeMeters being found on the
computer and if you look in the Windows Task Manager, the CodeMeter Runtime Server
service will be shown as Stopped.

w
E-J Windows Task Manager .w m .- Frw '_“. -e

File Options View Help

| Applications | Processes | Services |PerFormar1ce I Metworking I Users |

MName . PID Description Status Group

dr_gntimization w40 30319 54 Micro=oft MET Framework MGEM s Stonned LA

CodeMeter.exe CodeMeter Runtime Server Stopped N,F.ﬁ.)
oM YEADD COMT System Applcanon Stopped TIE

To start the CodeMeter Runtime Server service, click on the Configuration
>Server >Server access menu, then select Enable and finally click on Apply
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- & WebAdmin | Server Access b + - O
&« ( ‘@‘ ® localhost:22350/configuration/server_access.html e 1:? N @

CodeMeter WebAdmin C

SYSTEMS

Dashboard Container +  License Monitoring v  Diagnosis v [E@elsiile[sg-1uls]s 1%

E Server Configuration Server Access Basic N (2] B English (US)
Server Access License Access Permissions ( Server 2 Server Access )
—Network Server Advanced License Access Permiss
O Disable
MNetwork Port *: 22350

—CmWAN Server
O Disable

® Enable
CmMWAN Port *: 22351 |

‘ Apply ’ Restore Defaults

(*) Changes only take effect after restarting CodeMeter

You will be again be asked to confirm that it is to be done.

If you look in the Windows Task Manager, the CodeMeter Runtime Server service will be shown
as Running.

I-; Windows Task Manager

File Options View Help

| Applications | Processes | Services | performance | Networking | Users |

-

MName PID Description Status Group
o optimization v4.0.30310 84 Microsoft NET Framework NGEN v, Stooped M)
( CodeMeter.exe 124964 CodeMeter Runtime Server Running M/
LS eAnD T Dya e Appnea o ) 0o]n] ] Tm

Warning: Access to all the CodeMeters on the computer is stopped by stopping the CodeMeter
Runtime Server Service.
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11.2 Port Address for CodeMeter Communication

For CodeMeter WebAdmin 6, see 11.2.1 Port Address - WebAdmin 6 on page 86
For CodeMeter WebAdmin 5, see 11.2.2 Port Address - \WebAdmin 5 on page 87.

11.2.1 Port Address - WebAdmin 6

The CodeMeter License Server uses a specific IP port (defaulted on 22350) to communicate
with your computer and the network. This network port is registered at IANA (Internet Assigned
Numbers Authority) and is uniquely assigned for CodeMeter® communication.

Please make sure that your firewall is not blocking this port.

Enable the used IP port 22350 and make sure it is accessible by CodeMeter®, i.e. share the
communication for this IP port.

The IP port used for communication can be changed by the CodeMeter WebAdmin panel.

Click on the Configuration >Server >Server access menu.

&« ( ‘@‘ ® localhost:22350/configuration/server_access.html e 1:? In 0 =
WiBU CodeMeter WebAdmin C
SYSTEMS

Dashboard Container ~  License Monitoring v  Diagnosis v [E@elsiile[sg-1uls]s 1%

E Server Configuration Server Access Basic N (2] B English (US) ~
Server Access License Access Permissions C Server 2 Server Access )
—Network Server Advanced License Access Permis
O Disable
® Enable
(Network Port *: 22350 )
i

—CmWAN Server
O Disable

® Enable
CmMWAN Port *: 22351 |

Restore Defaults

(*) Changes only take effect after restarting CodeMeter

Change the Network Port: field to the number of the port that you want the CodeMeter to
communicate over, and then press Apply.

Important: For the change to take affect, you need to stop and then restart the CodeMeter
Runtime Server service. See 11.1 Stopping & Starting the CodeMeter Runtime Server on
page 80.
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11.2.2 Port Address - WebAdmin 5

The CodeMeter License Server uses a specific IP port (defaulted on 22350) to communicate
with your computer and the network. This network port is registered at IANA (Internet Assigned
Numbers Authority) and is uniquely assigned for CodeMeter® communication.

Please make sure that your firewall is not blocking this port.

Enable the used IP port 22350 and make sure it is accessible by CodeMeter®, i.e. share the
communication for this IP port.

The IP port used for communication can be changed by the CodeMeter WebAdmin panel.

Click on the Configuration >Server tab.

CodeMeter WebAdmin C\/J

Server

Bind Address: All (Default)

Run Network Server: [

( Network Port =: |2235D |>

Run CmWAN Server: [

CmWAN Port =: 22351 |

| Apply || Default |

(*) Changes only take effect after restarting CodeMeter

Change the Network Port: field to the number of the port that you want the CodeMeter to
communicate over, and then press Apply.

Important: For the change to take affect, you need to stop and then restart the CodeMeter
Runtime Server service. See 11.1 Stopping & Starting the CodeMeter Runtime Server on
page 80.
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11.3 Certifying CodeMeters

Updating the Certified Time in a CodeMeter must be done at least every two month over the
Internet and Certifying needs communication between the CodeMeter and a Certified Wibu
Time Server.

So for Certification to occur, a computer that can access the CodeMeter must also have access
to the Internet at least every two months so it can run the Certification.
Certifying a CodeMeter can be done
(a) manually from inside 12d Model itself
See 5.1 Certifying CodeMeters from 12d Model on page 30
(b) automatically by 712d Model
See 5.2 Automatically Certifying CodeMeters from 12d Model on page 32

(c) outside of 12d Model when the CodeMeter is on the computer you are using outside

Using the CodeMeter Control Centre - see 5.3 Certifying CodeMeters Using Control
Center on page 33.

or

(d) outside 12d Model when the CodeMeter is NOT on the computer your are using

It is possible to certify CodeMeters that are on other computers but this is usually only
needed by Administrators. See 11.3.1 Certifying CodeMeters Using WebAdmin on page 89

Important Note

To display and update the Certified Time in the CodeMeter, you need access over the Internet
to a CodeMeter Time Server (see 11.3.2 Time Servers for Certified Time on page 95) and this
Internet communication must be allowed to be done through an IP port (see 10 Network
CodeMeters on page 51).

Please contact your 72d Model Reseller if you are having problems certifying your CodeMeter.
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11.3.1 Certifying CodeMeters Using WebAdmin

If the CodeMeter is NOT attached to your current computer you need to use the
CodeMeter WebAdmin panel which is brought up by clicking on the WebAdmin button on the

CodeMeter Control Center.

@ CodeMeter Control Center

File Process View Help

License Events

Mo CodeMeter License information available.
Mo CmContainer found.

CodeMeter is started. WebAdmin

For CodeMeter WebAdmin 6, see 11.3.1.1 Certifying CodeMeters Using \WebAdmin 6 on

page 90
For CodeMeter WebAdmin 5, see 11.3.1.2 Certifying CodeMeters Using WebAdmin 5 on

page 94.
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11.3.1.1 Certifying CodeMeters Using WebAdmin 6

After getting up CodeMeter WebAdmin panel up, on the Dashboard you need to set the Current
Server to the server that the CodeMeter is on.

To get a list of servers, click on the Current Server: field at the bottom of the Dashboard and you
will get a list of the servers found.

c o @ localhost:22350/indexhtml - ¥ W @ =

CodeMeter WebAdmin C

SYSTEMS

BEELEIGE Container v License Monitoring v Diagnosis v Configuration v

@% Dashboard © = English (US) ~
Current Server: RanchDocco
IP-Address: 151
Operating System:  Microsoft Windows 10 Enterprise, 64-Bit
Server Startup: 2018-11-18 05:35:43
Server Version: Version 6.30a of Jul/28/2016 (Build 2266)
Runtime Version: 6.30a

Current Server: localhost (127.0.0.1) % WebAdmin Version: 6.30

Page 90 Certifying CodeMeters
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&« (G @ localhost:22350/index html e @ m @ =

Server found:

localhost (127.0.0.7)

s 12d.com (I 10)

Il s<rver.12d.com (192.168.68.252)

O Use IP-Address

| | Cancel |

If there is more than one CodeMeter on that computer/server, select the one that you want to
examine and click on Apply.

The information about the selected Server will be displayed, including any CodeMeters that are
found on the server and the current sessions on them.

- @ WebAdmin | Dashboard x e = [m] 4

« (& Q @ server.12d.com:22350/index.html| - ﬁ In =

CodeMeter WebAdmin Cr

SYSTEMS

Dashboard Container v License Monitoring v Diagnosis v Configuration v Info

ﬂ Dashboard (7] B English (US) ~

Sessions (2)

Current Server: SERVER

- . 12d Model - Stock
IP-Address: 252 docco.12d.com _1011956 - 12d Solutions - e
Operating System:  Microsoft Windows Server 2012 R2 Standard, 64-Bit : c51470113
Server Startup: 2018-10-15 16:28:48 101055 12d Model - Stock
Server Version: Version 6.40a of Dec/22/2016 (Build 2402) docco.12d.com .y ;;ffgf‘f‘;‘mﬁ e
Runtime Version: 6.40a

current Server JEServer (I 252) #% _ WebAdmin Version: 6.40

If there is more than one CodeMeter (CmContainer) on that computer/server, select the one
that you want by Walking right on the Container menu.

Certifying CodeMeters Page 91
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< c @ @ server.12d.com:22350/index.htm R

CodeMeter WebAdmin

SYSTEMS

Dashboard Container v License Monitoring v Diagnosis v Configuration v Info

@R Dashboard  A|| Container 5 | <no name> 2-1387203 e
(<no name>  2-2310233 )
<no name> 2-2310242

Sessions (2)

Current Server: SE choname>  3-4025920 e
IP-Address: 68.252 doceo.12d.com _1011955 24
Operating System:  Microsoft Windows Server 2012 R2 Standard, 64-Bit : c5147
Server Startup: 2018-10-15 16:28:48 12d b
101956

Server Version: Version 6.40a of Dec/22/2016 (Build 2402) docco.12d.com 7y ;51124‘1:
Runtime Version: 6.40a

Information about the selected CodeMeter is then displayed.

Click on the CmContainer Info button to expand the information displayed.

. & WebAdmin | Container b + - O
<« (& Q (O] server.12d.com:22350/container/cmcontainer_details.html?BoxSerial=2-2310233 e @ 1:? i @

CodeMeter WebAdmin C

SYSTEMS

Dashboard (oI  License Monitoring ~  Diagnosis v Configuration ~  Info

B Al Container  <no name> (2-2310233) © = English (US)

<D <no name> 2-2310233 CmStick 2.04

3!
‘ A Licenses CmContainer Info Backup & Restore

~ 100003 Bundling Articles

Product Code Name Unit Counter WValid Until License Quantity Feature Map

1 Securikey Lite n/a n/fa 1 0Ox1l

A 101956 12d.com

Product Code Name Unit Counter WValid Until License Quantity Feature Map
1 12d Model - Stock - 12d Solutions - ec51470113 n/a n/fa 5 n/a
1 12d Model - Stock - 12d Solutions - ec51470114 nfa nfa 25 nfa

current Server: [IIlserver (I 252) % i WebAdmin Version: 6.40

The current Certified time for that CodeMeter will be displayed.
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The Certified time for that CodeMeter can be updated to the current date by clicking on the
Update button.

. & WebAdmin | Container b + - m]
&« (& 'Q ® server.12d.com:22350/container/emecontainer_details.html?BoxSerial=2-2310233 = ﬁ In D =
CodeMeter WebAdmin C
SYSTEMS

Dashboard

Container v License Monitoring ~ Diagnosis v Configuration v Info

I Al Container  <no name> (2-2310233) © = English (US) ~

<no name:> 2-2310233 CmStick 2.04 .

Licenses A CmContainer Info Backup & Restore

MName <no name>
Serial Number 2-2310233
CmContainer Type CmStick 2.04 click to update the
First Device I: (No Flash) Certified time
Status @ Enabled
System Time (PC) 2018-12-23 16:22:51
System Time (CmContainer) 2018-12-23 16:22:48
( Certified Time (CmContainer) 2018-12-05 14:55:29 ) O
Free Memory

@ - WebAdmin Version: 6.40

If you have permission to do so, the Certified time for that CodeMeter can be updated to the
current date by clicking on the Update button.

Please contact your 12d Model Reseller if you are having problems certifying your CodeMeter.

Important Note

To display and update the Certified Time in the CodeMeter, you need access over the Internet
to a CodeMeter Time Server (see 11.3.2 Time Servers for Certified Time on page 95). This
Internet communication is through a set IP port (see 10 Network CodeMeters on page 51).

Certifying CodeMeters Page 93
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11.3.1.2 Certifying CodeMeters Using WebAdmin 5

After getting up CodeMeter WebAdmin panel up, on the Home tab set the Host Name: field to the
name of the computer or server that the CodeMeter to be certified is on, and then go to the
Content >CmContainer tab.

CodeMeter WebAdmin C\A

Diagnosis

Licenses User Data Backup/Restore

CmContainer: |2-2310278 [v]
Name: <no name:

CmContainer Type: CmStick 2.04

First Device: Mo drive assigned (HID)
Status: Ooisabled

Certified time Enabled until Unplugged CIiCk. t.O up_date the
Certified time

mEnabled

System Time (PC): 2015-09-03 17:40:47 J

System Time (CmContainer): 2015-09-03 17:40:47

(Certified Time (CmContainer): 2015-09-03 1?:13:359 ( Update ’
Free Memory: 93 % (367.432 Bytes) Defragment

If there is more than one CodeMeter (CmContainer) on that computer/server, select the one
that you want to examine in the CmContainer: field.

The Certified time for that CodeMeter can be updated to the current date by clicking on the
Update button.

Please contact your 12d Model Reseller if you are having problems certifying your CodeMeter.

Important Note

To display and update the Certified Time in the CodeMeter, you need access over the Internet
to a CodeMeter Time Server (see 11.3.2 Time Servers for Certified Time on page 95). This
Internet communication is through a set IP port (see 10 Network CodeMeters on page 51).

Page 94 Certifying CodeMeters
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11.3.2 Time Servers for Certified Time

When you certify a CodeMeter it searches the internet for a CodeMeter Time Server to update
the Certified Time in the CodeMeter.

For CodeMeter WebAdmin 6, see 11.3.2.1 Time Servers - WebAdmin 6 on page 95
For CodeMeter WebAdmin 5, see 11.3.2.2 Time Servers - WebAdmin 5 on page 96.

11.3.2.1 Time Servers - WebAdmin 6

For a particular CodeMeter on a Server, the Internet or IP addresses of the CodeMeter Time
Servers that are searched to set the Certified Time are given in the Configuration >Certified
Time tab of the CodeMeter WebAdmin panel.

@ WehAdmin | Container a @ WebAdmin | Dashbaard *

& c ‘Q‘ @ server.12d.com:22350/index.html v @ ﬁ N &

CodeMeter WebAdmin C

SYSTEMS

Dashboard Container v License Monitoring v Diagnosis ¥+ Configuration v Info x

@B Dashboard

Basic > © = English (US)
Server > a
Current Server: SERVER ( ad . LT ()
vance:

- . 12d Model - Stock
IP-Address: 222 docco.12d.com _1011955 - 12d Solutions - &
Operating System:  Microsoft Windows Server 2012 R2 Standard, 64-Bit . c51470113
Server Startup: 2018-10-15 16:28:48
Server Version: Version 6.40a of Dec/22/2016 (Build 2402)

Runtime Version: 6.40a

The list of Time Servers used for this CodeMeter are then displayed.

&« c ‘m @® server.12d.com:22350/configuration/certified_time.htmi

CodeMeter WebAdmin

SYSTEMS

Dashboard  Container ~  License Monitoring ¥  Diagnosis ~ [ESsTalils[¥g=1ale RS

{}g Advanced Configuration Time Server

Time Server Extra

FTime Server \

1. cmtime.codemeter.com

2. cmtime.codemeter.us
3. cmtime.codemeter.fr

4. cmtime.codemeter.de

Time Out: 20 Seconds

The Time Servers list is searched in order from the top to the bottom.
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Servers in the list are added or removed using the add or remove buttons, and a highlighted entry
in the list is moved up or down with the up and down buttons.

Clicking Apply saves these entries in the Windows Registry of the Server that the CodeMeter is
on.

11.3.2.2 Time Servers - WebAdmin 5

For a particular CodeMeter on a Server, the Internet or IP addresses of the CodeMeter Time
Servers that are searched to set the Certified Time are given in the Configuration >Certified Time
tab of the CodeMeter WebAdmin panel.

CodeMeter WebAdmin C\/J

Configuration

Diagnosis

MNetwork Server Proxy Access Control WebAdmin Backup Borrowing

Certified Time

Time Server: [cmtime.codemeter.com
cmtime.codemeter.us
cmtime.codemeter.fr
cmtime.codemeter.de

| add || remove || up || down |

Time Cut: sec

| Apply || Default |

The Time Servers to search are given in the list labelled Time Server: and the list is searched in
order from the top to the bottom.

The Timer Servers can be specified by either an Internet address or an IP address.

Servers in the list are added or removed using the add or remove buttons, and a highlighted entry
in the list is moved up or down with the up and down buttons.

Clicking Apply saves these entries in the Windows Registry of the Server that the CodeMeter is
on.

Page 96 Certifying CodeMeters
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11.4 Monitoring and Cancelling Licenses

Clicking on the WebAdmin button brings up the CodeMeter WebAdmin panel which can display
information about 72d Model licenses for any CodeMeter (Network or Standalone) that is visible
on the computer network.

For instructions on finding information about CodeMeters on a particular Network Server, see

11.4.1 Getting Info on CodeMeters on a Particular Server - WWebAdmin 6 on page 98
11.4.3 Getting Info on CodeMeters on a Particular Server - WebAdmin 5 on page 105.
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11.4.1 Getting Info on CodeMeters on a Particular Server - WebAdmin 6
Clicking on the WebAdmin button brings up the CodeMeter WebAdmin panel which can display
information about 72d Model licenses for any CodeMeter (Network or Standalone) that is visible
on the computer network.

The panel comes up with the Dashboard tab displaying information about one of the
CodeMeters on this computer.

To get information about CodeMeters on another Server, you need to set the Current Server to
the server that you wish to exam CodeMeters on.

To get a list of servers, click on the Current Server: field at the bottom of the Dashboard:

c @ @ localhost:22350/indexhtml o & 1y n @ =

CodeMeter WebAdmin C

SYSTEMS

BEELEIGCI Container ~  License Monitoring ~  Diagnosis ¥  Configuration ~  Info

@B Dashboard © = English (Us) ~
Current Server: Docco
IP-Address: 151
Operating System:  Microsoft Windows 10 Enterprise, 64-Bit
Server Startup: 2018-11-18 05:35:43
Server Version: Version 6.30a of Jul/28/2016 (Build 2266)
Runtime Version: 6.30a

Current Server: localhost (127.0.0.1) % - WebAdmin Version: 6.30
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If there is more than one CodeMeter on
that computer/server, select the one that
you want to examine and click on Apply.

Server found:

localhost (127.0.0.7)
5. 12d.com (EEEEEEES. 10)
Hl-rver.12d.com (I 252

O Use IP-Address

| Apply | | Cancel |

Important Note:
It is possible to have different versions of WebAdmin installed on different Servers.

So depending on which Server you are looking at, you may now need to swap between the
notes for WebAdmin 6 and WebAdmin 5.
For instructions on Monitoring and Cancelling Licenses on this Server, see

11.4.2 Monitoring and Cancelling Licenses - WebAdmin 6 on page 100
11.4.4 Monitoring and Cancelling Licenses - WebAdmin 5 on page 107.
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11.4.2 Monitoring and Cancelling Licenses - WebAdmin 6
The information about a selected Server will be displayed, including any CodeMeters that are
found on the server and the current sessions on them.

- @ WebAdmin | Dashboard b -+ - O
« [CEA} @ server.12d.com:22350/index.htm| e i o =

CodeMeter WebAdmin C

SYSTEMS

Dashboard Container v License Monitoring v Diagnosis v Configuration v Info

ﬁ Dashboard (7] B English (US) ~
Current Server: SERVER SEEIIE (2]

— . 12d Model - Stock
IP-Address: 252 docco.12d.com .101956 - 12d Solutions - e
Operating System:  Microsoft Windows Server 2012 R2 Standard, 64-Bit : c51470113
Server Startup: 2018-10-15 16:28:48 101056 12d Model - Stock
Server Version: Version 6.40a of Dec/22/2016 (Build 2402) docca.12d.com 7y - 12d Solutions - e

c51470113
Runtime Version: 6.40a

To find out information about all the CodeMeters (CmContainer) on that computer/server, select
the Container >All Containers option, and expand the 12d Model product code 101956 for
each CodeMeter to show any virtual 12d dongles in a CodeMeter or any standalone
CodeMeters.
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The example below shows a Server with three CodeMeters attached to it: one with a single
virtual 12d dongle, one with two virtual 12d dongles and one which is a standalone CodeMeter.

< ¢ o 0]
I N|[|={§ Dashboard [NEGICIWEIEEE License Monitoring v Diagnosis v Configuration v Info
SYSTEMS

server.12d.com:22350/container.html b o o =

i All Container (2] B English (US) ~

v 99 Firm Security Box Item
+ 100003 Bundling Articles
v 100021 WIBU-SYSTEMS AG

(12d Model product code>

§  <noname> 2-2310233 \

ALY

L A License CmiContainer Tnfo Bacliin and Bactar

two virtual 12d dongles in the one CodeMet@

v 0003 S
~ (101956) 12d.com f

CodeMeter numbers ®

Product C =TT Unit Counter Afalid Until License Quantity Feature Map
1 12d Model - Stock - 12d Solutions - ec51470113 5 nfa
1 12d Model - Stock - 12d Solutions - ec51470114 25 nfa

<no name:> 2-2310242 CmStick 2.04 .

ot
\ M Licenses CmContainer Info Backup and Restore
100003 Bundling Articl - A
e Hneing ArHCEs (one 12d Model virtual dongle in a CodeMeter>
101956 12d.com
Product Code Name Unit Counter WValid Until License Quantity Feature Map
1 12d Model - 12D Solutions - NSW - ec51470101 nfa n/a 2 nfa
(one standalone 12d Model CodeMe@r

<® <no name:> 3-4025920 CmStick 4.01 [ ]
e
& A Licenses CmContainer Info Backup and Restore

A 101956 12d.com
Product Code Name Unit Counter WValid Until License Quantity Feature Map

1 12d Model - 12d Solutions - 5c2d470acl nfa n/a 1 nfa

Current Sewer:‘ERVER (-252) WebAdmin Version: 6.40
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If there is more than one CodeMeter (CmContainer) on the computer/server, information about
just one of them can be obtained by walking right on the Container >All Container menu and
selecting the required CodeMeter number.

A ¢ @ ® server.12d.com:22350/index.html . @ 0

CodeMeter WebAdmin

SYSTEMS

BEELLE«M Container ~  License Monitoring v Diagnosis ~  Configuration ~  Info

@R Dashboard Al Container y <no name> 2-1387203 (2] =]
(<no name>  2-2310233 )
N
IP-Address: 8404 docco.12d.com _1011956 -lzfzrgii‘n;
Operating System:  Microsoft Windows Server 2012 R2 Standard, 64-Bit ' €51470113
Server Startup: 2018-10-15 16:28:48 12d Model -
Server Version: Version 6.40a of Dec/22/2016 (Build 2402) docco.12d.com 17195 i sout

Runtime Version: 6.40a

Information about the selected CodeMeter is then displayed. Expanding the 12d Model product
code 101956 will show any virtual 12d dongles in a CodeMeter.

&« (&l ‘G} O] server.12d.com:22350/container/cmcontainer_details.html?BoxSerial=2-2310233 e @ fr n @

CodeMeter WebAdmin C

SYSTEMS

DEGEIGI  Container ~ License Monitoring ~  Diagnosis ~  Configuration ~  Info

E All Container <no name> (2-2310233) e B English (US)

< <no name> 2-2310233 CmStick 2.04 .

Q
’ A Licenses CmContainer Info Backup & Restore

A 100003 Bundling Articles
Product Code Name Unit Counter Valid Until License Quantity Feature Map

1 Securikey Lite n/a nfa 1 oxl

A 101956 12d.com

Product Code Name Unit Counter Valid Until License Quantity Feature Map
1 12d Model - Stock - 12d Selutions - ec51470113 n/a nfa 5 nfa
1 12d Model - Stock - 12d Solutions - ec51470114 n/a n/fa 25 n/a

Current Sewer:-SERVER (I >52) - WebAdmin Version: 6.40

And as discussed in the Certifying section, clicking on the CmContainer Info button expands the
information displayed for the CodeMeter.
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To see information about the total number of licenses available for each virtual 12d dongle, and
the number of licenses currently being used and how many are left to use, click on the
License Monitoring >All Licenses menu.

@ WebAdmin | Container
<« () Q @ server.12d.com:22350/container/cmcontainer_details.htm|?BoxSerial=2-2310233 e i} I @

CodeMeter WebAdmin C

SYSTEMS

Dashboard Container v License Monitoring v Diagnosis ¥+  Configuration ¥  Info

E All Container <noname A|| Licenses (2] B English (US) ~
Sessions .
<no namex> 2-2310233 CmsStick 2.04 @
Q
% Licenses 4 CmContainer Info Backup & Restore
Name <no name>

Information about the selected CodeMeter is then displayed.

. & WebAdmin | License Monitorin X [ian

<~ c @ @ server.12d.com:22350/license_monitoring.htm| e o INn @ =

CodeMeter WebAdmin C

SYSTEMS
[DET ol s I 0TI 1 a =gl License Monitoring Diagnosis ~  Configuration ~  Info
=£' All Licenses (2] B English (Us) ~
Available Licenses on SERVER

v 10 CodeMeter Test Firm Code

v 99 Firm Security Box Item

v 100003 Bundling Articles
v 100021 WIBU-SYSTEMS AG

A 101956 12d.com

Product Code * Name Feature Map License Quantity Used Available

1 12d Model - 12D Solutions - NSW - ec51470101 - 3 0 3

1 12d Model - Stock - 12d Solutions - ec51470113 - 5 2 3

1 12d Model - Stock - 12d Solutions - ec51470114 - 25 0 25

1 12d Model - 12d Solutions - 5c2d470acl - 1 0 1
Monitoring and Cancelling Licenses Page 103
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. & Webadmin | License Monitorin X [ian
<« & ‘Q‘ @ server.12d.com:22350/license_monitoring.html v fr In @ =

CodeMeter WebAdmin C

SYSTEMS

Dashboard Container ~ ENERGEGICELIIEN Diagnosis ¥  Configuration ~  Info

8% Al Licenses © = Engliish (US) ~

N i f >
Available Licenses on 'BUILD-SERVER' (”mbero ieenses ee

v 10 CodeMeter Test Firm Code

(one 12d Model virtual dongle in a CodeMeter )

v 100003 tho 12d Model virtual dongles in a CodeMeter )
v 100021 WIBU-SYJTEMS AG Number of licenses on
A 101956 12d.co each virtual 12d dongle v

Q\lumber of licenses being usecD

Product Code * Name Feature Map License Quanti Used Available
1 12d Model - 1§Pp Solutions - NSW - ec51470101 - 3 0 3
1 12d Model - Stock - 12d Solutions - ec51470113 - 5 2 3
1 CZd Model - Stock - 12d Solutions - ec51470114> - 25 0 25
1 12d Model - 12d Solutions - 5c2d470acl - 1 0 1

Information last updated on 2018-12-25 11:29:20

Clicking on the Product Code 1 for a CodeMeter showing some licenses are being used will (for
example ec514470113), displays the user name of the user of each license (session).

If you have the required permission, the session can be terminated by selecting Cancel at the
end of the session row and in the Action column.

c @ ®

server.12d.com:22350/license_monitoring/license_monitoring_details.htm!|? - @ i In @ =

CodeMeter WebAdmin C

&«

SYSTEMS

Info

Dashboard  Container v JENCGEREGGTGILGIEEE Diagnosis ~  Configuration ~

485 AllLicenses  <no name> (2-2310233) - Entry 101956:1 (-) © = English (US) ~

License Monitoring Details @Ser for the SGSSiorD

Glick to Cancel the sessioD

Total

CmContainer Availotie

<no name> (2-2310233) 101956:1 (-)

Client Application Access

eI et Mode First Access Last Access Expires Action

D Client (User)

151 ( _, 2018-12-25 2018-12-26
151 ( - 2018-12-25 2018-12-26
220 Candice) 0 Usertimit  yg5.30:53 12:10:35

Information last updated on 2018-12-26 12:11:17

Current Server:| R - WebAdmin Version: 6.40
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11.4.3 Getting Info on CodeMeters on a Particular Server - WebAdmin 5

Clicking on the WebAdmin button brings up the CodeMeter WebAdmin panel which can display
information about 712d Model licenses for any CodeMeter (Network or Standalone) that is visible
on the computer network.

The panel comes up with the Content >CmContainer tab displaying information about one of
the CodeMeters on this computer.

CodeMeter WebAdmin C\/J

Home Content Brver onfiguration Diagnosis nfo Help

Licenses User Data Backup/Restore

CmContainer: [2-2310278 [v]
Name: <no name:

CmContainer Type: CmStick 2.04

First Device: Mo drive assigned (HID)
Status: Ooisabled

Enabled until Unplugged

ﬁ Enabled

System Time (PC): 2015-08-14 17:24:11
System Time (CmContainer): 2015-08-14 17:24:10

Certified Time (CmContainer): 2015-08-14 15:36:01 Update
Free Memory: 93 % (367.432 Bytes) Defragment

CodeMeters on other computer can be examined by clicking on the Home tab and then clicking
on the displayed Host Name: to bring up the panel to select a Server to check for CodeMeters.

A pop up list is automatically created of all the computers that are visible on the network and
have CodeMeters on them.
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CodeMeter WebAdmin

CvJ

T N
Home onten

Host Name:

IP Address:

Operating System: Microsoft \

Server Startup:
Runtime Version:

Server Version:

WebAdmin Version: Version 5.

Server Configuration Diagnosis nfo
Americiure B
2 CodeMeter | WebAdmin - Internet ... l = éj

.6 |E http://localhost:22350/SelectServer.html

Aug/13/20)
5.10b

Version 5.

CodeMeter Web Administration

Select a Server
[localhost (127.0.0.1) [v]

[ use 1P Address

601), 64-bit

Intranet settings are turned off by default.

Picking a Server/Computer from the list and then pressing Select will set the Host Name: to the
selected computer and all the tabs on the CodeMeter WebAdmin panel will then show information

about the CodeMeters on the selected computer.

Important Note:

It is possible to have different versions of WebAdmin installed on different Servers.
So depending on which Server you are looking at, you may now need to swap between the

notes for WebAdmin 6 and WebAdmin 5.

For instructions on Monitoring and Cancelling Licenses on this Server, see

11.4.2 Monitoring and Cancelling Licenses - WebAdmin 6 on page 100

11.4.4 Monitoring and Cancelling Licenses - WebAdmin 5 on page 107.
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11.4.4 Monitoring and Cancelling Licenses - WebAdmin 5

The tab Content >Licenses will display information about any selected CodeMeter on the

selected computer.

CodeMeter WebAdmin

Cwﬂ

ome Content erver Configuration Diagnosis  Info Help
CmContaineUser Data Backup/Restore
CmContainer: [2-2310233 [v]
100002 | Bundling Articles
Product Norme Unit Expiration Activation License
Code Counter Time Time Quantity
3l SecuriKey Lite n/a nfa nfa 1
101956 | 12d.com
Product Name Unit Expiration Activation License
Code Counter Time Time Quantity
12d Model - Stock - 12d
1 Solutions - ec51470113 n/a a a >
12d Model - Stock - 12d
- Solutions - ec51470114 i n/2 i =

To see how many 12d Model licenses are being used by each virtual 12d dongle in all the
CodeMeters on a particular Server, when that server has been selected on the Home tab, click

on the Server >User tab.
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CodeMeter WebAdmin |
Server Configuration Diagnosis Info Help

Cluster User

Available Network Licenses at '"BUILD-SERVER'

[HITIE Name Eeatuee Licenses Status
Code Map
o No
ders L User Ex_clu— Shared | Free
(Borrowed) Limit | Sive

10 | CodeMeter Test Firm Code

13 Test Entry = 1 0(-) 0 0 0 1

CmDemo

for C++ (one 12d Model virtual dongle in a CodeMeter b
etails
[

1608 created this -
Product | [ [ [ [

[
ftem / ("two 12d Model virtual dongles in a CodeMeter >

/ /{01956 | 12d.com
12d Model - .
120 \Z /(\ Number of licenses on\K
1 Soll\lustit\:{ns - - 3 each virtual 12d dongle 3
ec51470101 . /
/12d Model - l&/
Stock - 12d -
! Solutions - 5 2(9) 0 0 0 3
ec51470113
12d Model -
Stock - 12d H .
1 || Solutions - 25 @umber of licenses fre§ 25
\\ec514?0114 —/ | | I \_/

Information last updated on Aug/14/2015 19:47:58

The 12d dongles are displayed under the section titled 101956 | 12d.com.

The table also displays how many 72d Model licenses are on each 12d dongles, and how
many of those licenses are still Free to be used.

Details about each user on a particular 12d dongle is displayed by clicking on the Details button
at the end of the row for that virtual 12d dongle.
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Home Content |[2:324 Configuration Diagnosis Info Help
Cluster User
License Details CmContainer 2-2310233
Entry 101956 : 1 (-)
Free 3
Total 5
Client Sl =
o Applicati Al First Last = =
ID | Client (User) | Process P aon e e o Expires | Action
D Information | Mode Access Access
2015-08- | 2015-08-
117 User
229 0 e 14 14 [ cancel |
(UBCEU ) Lmit | 9.41:48 | 19:40:22
2015-08- | 2015-08-
i iy User
242 0 G 14 14 Cancel
(USRI ) Lmit | 49.41:57 | 19:48:15
Information last updated on Aug/14/2015 19:49:25

A particular user session of 72d Model can be stopped by clicking on the Cancel button.

A Confirmation panel will then be brought up.

-

Message from webpage

|

I Do you really want to delete User '229' (192.168.68.11717

oK

J

Cancel

L

A

If you click on OK and have permission to be able to stop people, the session will be terminated.

If you do not have permission, you will get the message
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WebAdmin CodeMeter C\d

Home  Content  Server Configuration  Diagnosis  Info

HTTP ERROR 403

The access to the CodeMeter Server was not permitted,
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11.5 Updating Licenses in Network CodeMeters

A Network CodeMeter can contain one or more virtual 12d dongles and each of these virtual
dongles can have a different number of 72d Model licenses.

Adding extra 12d dongles, or modifying the number of licenses on each of the 12d dongles can
be done electronically without having to remove the Network CodeMeter from the computer.

Updating virtual 12d dongles is usually one simple step but it may involve two steps.

Step 1.Generating the CodeMeter Context File (.WibuCmRaC) - only if asked for

The context (.WibuCmRaC) file holds information about the current settings in the Network

CodeMeter. 12d Solutions usually knows these setting for your Network CodeMeter and
this step is normally not required.

However sometimes you may be asked to generate the .WibuCmRaC file and email it to
your local 12d Model Distributor.

If you need to generate the .WibuCmRaC file, go to 11.5.1 Generating the Context File
(WibuCmRac) on page 112.

Step 2.Updating the Network CodeMeter with the .WibuCmRaU file

You will be emailed one or more special files (ending in .WibuCmRaU) which are used to
update the information about the virtual 12d dongles in the Network CodeMeter.

If you have a WibuCmRaU file, go to 11.5.1.1 Updating Using the .WibuCmRaU File on

page 115.
Updating Licenses in Network CodeMeters Page 111
— = = == = < 72
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11.5.1 Generating the Context File (. WibuCmRac)

The follow steps will generate a new context file for a Network CodeMeter using the CodeMeter
Control Center panel.

The CodeMeter Control Center panel is accessed by clickingon — g
the CodeMeter icon that was installed on your task bar.

(& CodeMeter Control Center g

License Events Borrow

@ CmStick Name:
2-2310262

[2-2310242 |

Serial: 2-2310262

Version: CmStick 2.04

GHERE

Capacity: 93 % free (367400 Bytes)

Click on License Status: @ () Disabled
Update 2 (2 Enabled until unplugged
© (& Enabled

License Update Eject Change Password
CodeMeter is started. Webadmin

e

Click on License Update to bring up the CmFAS Assistant panel.

(& CmFAS Assistant L9 o]

Welcome to the CmFAS Assistant!

The CodeMeter Field Activation Service (CmPAS) assistant helps you adding,
changing and deleting licenses from the license management system CodeMeter.

With the CmFAS assistant you can create license request files, which you can send
to the producer of the software by email. You can also import the received license
update files with the CmFAS assistant into the license management and create a
receipt of the import for the producer.

< Back MNext = ] [ Help
p y
Select Next.
Page 112 Updating Licenses in Network CodeMeters
E— = L
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& CmFAS Assistant P =

Please select the desired action

) Create license request

Choose this option if you want to create a license request file in order to send it
to the producer of the software.

) Import license update

Choose this option, if you received a license update file from the software
producer and want to import this file,

@ Create receipt

Choose this option if you want to confirm the successful import of a license
update file for the software producer.

Click on Create receipt

[ < Back ][ Next = ][ Help

Tick on Create receipt and then select Next.

(& CmFAS Assistant |9 [

Please choose the producer

i12d,com (101956)

Tick on 12d.com

Select the software producer to which you want to send the receipt file. The
producer will anly see the data which you select here. So you can ensure that the
producer doesn't see which ather licenses from other suppliers you have,

[ < Back ][ Mext = ][ Help

“

Tick on 12d.com and then select Next.

Updating Licenses in Network CodeMeters Page 113
== = == = L 7z
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& CmFAS Assistant 7] =

Please select the file name

€:/12d Jobs/2-2310278. WibuCmRaC ™

Select a file name for staring the receipt file file. Then dick on 'commi create the
file. You can then send this file to the producer by email,

Select the folder where the file is to be written to.
Leave the actual file name as it is.

Click on Commit

[ < Back Commit l[ Help ]

Select the file to use to update the CodeMeter and then select Commit.
Email the .WibuCmRacC file to your 712d Model Reseller.

Your 12d Model Reseller will then be able to send you a .WibuCmRaU file to update your
Network CodeMeter.

For information on how to use a .WibuCmRaU f file to update the CodeMeter, see 11.5.1.1
Updating Using the .WibuCmRaU File on page 115.
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11.5.1.1 Updating Using the .WibuCmRaU File

The number of virtual 712d dongles and the number of 72d Model licenses on them can be
changed electronically without having to remove the CodeMeter from the computer.

To update the CodeMeter, you will be sent a file starting with the CodeMeter number, then the
date and finally ending in .WibuCmRau.

The steps below will show how to use the .WibuCmRau file to update the Network CodeMeter
You need to have System Administrator rights to update the Network CodeMeter.

Before updating a Network CodeMeter dongle, run the CodeMeter WebAdmin software to
check that no one is using the Network CodeMeter (11.4 Monitoring and Cancelling Licenses on
page 97). The CodeMeter WebAdmin displays network dongle activity and it can also remove
users from the network dongle.

Once all the users are off the Network CodeMeter, double click on the file
codemeter_number_date.WibuCmRau and the following panel will appear:

WIBU-SYSTEMS Shell Extension l J

i "y Do you want to transfer the file contents of
Y ChUsers\ljg\AppDatatLocal\Microsoft\Windows\Temporary Internet
~ Files\Content.Outlook\ LPCZERTF2-2310247-2015-08-13(1). WibuCmRa
U into the suitable CmAct license?

Yes | Mo |

e A

Select Yes and a panel to say how many CodeMeters have been updated should appear.

([ CmRmtActsa [ |

|0| 0 Cr5ticks successfully updated.

Click on OK >

L% &

The CodeMeter should now be updated. The CodeMeter WebAdmin can be used to check that
the new number of licenses, or new number of 12d dongles, are now available.

WARNING: If there is no association for the .WibuCmRau file, double clicking on
the .WibuCmRau file won’t work. In that case go to 11.5.1.2 Manually Updating the Network
CodeMeter on page 116.

Nodes.4d:

If you've added a new virtual 12d dongle to your CodeMeter then a new nodes.4d file with that
12d dongle number in it will be needed. If all you did was change the number of licenses for an
existing 72d dongle in the Network CodeMeter then a new nodes.4d file is not required.

§
1)
I
S
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~

icenses in Network CodeMeters Page 115
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11.5.1.2 Manually Updating the Network CodeMeter

If there is no association with the .WibuCmRau file then double clicking on the .WibuCmRau
file won’t automatically run the CodeMeter update program. So instead, the update will have to

be done manually using the CodeMeter Control Center panel.

The CodeMeter Control Center panel is accessed by clickingon — g
the CodeMeter icon that was installed on your task bar.

p
(& CodeMeter Control Center g
License Events Borrow
@ CmStick Name: &
2-2310262
[2-2310242 |
Serial: 2-2310262 @
Version: CmStick 2.04
Capacity: 93 % free (367400 Bytes)
Click on License status: © () Dissbled
Update 2 (2 Enabled until unplugged
] @ Enabled
License Update Eject Change Password
CodeMeter s started.

e

Click on License Update to bring up the CmFAS Assistant panel.

(89 CmFAS Assistant

73] |

Welcome to the CmFAS Assistant!

The CodeMeter Field Activation Service (CmPAS) assistant helps you adding,
changing and deleting licenses from the license management system CodeMeter.

With the CmFAS assistant you can create license request files, which you can send
to the producer of the software by email. You can also import the received license
update files with the CmFAS assistant into the license management and create a
receipt of the import for the producer.

< Back MNext = ] [ Help

“

Select Next.

Updating Licenses in Network CodeMeters
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& CmFAS Assistant L9 o]

Please select the desired action

7} Create license request

Choose this option if you want to create a license request file in order to send it
to the producer of the software.

@ Import license update

Choose this option, if you received a license update file from the software
producer and want to import this file,

I Create receipt

Choose this option if you want to confirm the successful import of & license
update file for the software producer,

Click on Import license update

[ < Back ] [ MNext = ] [ Help
Tick on Import license update and then Next.
r@ CmFAS Assistant R0

Please select the file name

C:/12d Jobs/2-2310247-2015-08-13. WibuCmRal )

lect a file under which the license update file is stored on your computer. Then dick
on 'commit’ to import the new licenses,

Select the file to use to update the CodeMeter

\

’ < Back ” Commit l[ Help ]

Click on Commit

L

Select the file to use to update the CodeMeter and then select on Commiit.

Nodes.4d:
If you've added a new virtual 12d dongle to your CodeMeter then a new nodes.4d file with that
12d dongle number in it will be needed. If all you did was change the number of licenses for an
existing 72d dongle in the Network CodeMeter then a new nodes.4d file is not required.

Note - if the CodeMeter that the file applies to is not on the computer then an Error message will
be brought up. See 11.5.2 Errors Updating the Network CodeMeter on page 118.
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11.5.2 Errors Updating the Network CodeMeter

If there was a problem, instead of the dialogue stating that the CodeMeter has been updated, a
CodeMeter error panel will appear. For example:

@ CodeMeter [&J
Error:
Update for CmDongle 2-2310247 FirmItem 101956 --> Box not found

If you can’t work out what your error was, email the error message to your 12d Model Reseller.

Doing a Print Screen and saving the png or bmp is the best way to record details of the error and
send the image to your 712d Model Reseller.
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11.6 Replacing an Existing Network CodeMeter

Before removing a Network CodeMeter, run the CodeMeter WebAdmin software to check that no
one is using the Network CodeMeter dongle (11.4 Monitoring and Cancelling Licenses on

page 97).

If there are no user on the Network CodeMeter, the existing Network CodeMeter can be removed
from the computer and the new Network CodeMeter attached.

The new Network CodeMeter should now be ready to use.

NOTE - a new nodes file will be required for the new virtual 12d dongles that are in the new
Network CodeMeter.

11.7 End of the Notes on Network CodeMeters

This ends the general notes on the Network CodeMeter.

However information on Certifying Network CodeMeters is covered in 9 Errors Installing and
Authorising on page 47.

If you need to install 12d Model on a computer, go to the section 2 Installing 12d Model 15
Release Version on page 6.

The links for downloading documentation on 72d Model are given in 6 Documentation on
page 40.

The links for downloading information, power points and videos on what is new in 72d Model 15
are given in 7 What's New in 12d Model 15 on page 45.
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11.8 Which Version of WebAdmin?

Clicking on the WebAdmin button brings up the CodeMeter WebAdmin panel which can display
information about 712d Model licenses for any CodeMeter (Network or Standalone) that is visible
on Servers in the computer network.

Depending on when the CodeMeter was installed on a particular Server, you can get different
versions of the WebAdmin pages.

If on a Server the WebAdmin Dashboard page looks like:

@& WebAdmin | Dashboard X

¢ @ index.html - @ In @ =
CodeMeter WebAdmin C In this case you need to follow
SYSTEMS instructions and images for
CodeMeter WebAdmin 6

DELGEIGGI Container v License Monitoring v Diagnosis v Configuration v Info ~

@B Dashboard @ = english(us) ~
Current Server: Docco
1P-Address: 151
Operating System:  Microsoft Windows 10 Enterprise, 64-Bit
Server Startup: 2018-11-18 05:35:43
Server Version: Version 6.30a of Jul/28/2016 (Build 2266)
Runtime Version: 6.30a

Current Server: localhost (127.0.0.1) & i WebAdmin Version: 6.30

Otherwise if the WebAdmin Home page on a Server looks like:

Index

CodeMeter | WebAdmit X ‘ + v

@ localhost:22350/Content. html?BoxSerial=3-3375053

CodeMeter WebAdmin C\/.l
LT T content erver Configuration Diagnosis Info Help

CmContainer Licenses User Data Backup/Restore

In this case you need to follow

CmContainer: . . .
e instructions and images for

ame: <no names
CmContainer Type: Cmstick 2.05 CodeMeter WebAdmin 5
First Device: No drive assigned (HID)
Satu=: Doisabled

Enabled until Unplugged
B enabled

System Time (PC): 2018-12-23 13:59:36

System Time (CmContainer): 2018-12-23 13:59:29
Certified Time (CmContainer): 2016-01-29 12:27:24
Free Memory: 94 % (315.640 Bytes) | Defragment

Important Note:
It is possible to have different versions of WebAdmin installed on different Servers.

So depending on which Server you are looking at, you may need to swap between the notes
for WebAdmin 6 and WebAdmin 5.
For instructions on finding information about CodeMeters on a particular Network Server, see

11.4.1 Getting Info on CodeMeters on a Particular Server - WebAdmin 6 on page 98
11.4.3 Getting Info on CodeMeters on a Particular Server - WebAdmin 5 on page 105.

Page 120 Which Version of WebAdmin?
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